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A Word With YouA Word With YouA Word With YouA Word With YouA Word With You

Dear Learner,

Welcome to the course on Employability Skills!

You have just taken your first step towards realizing your goals. Often the most difficult part is
to make a beginning. However, once you begin, you would want to keep improving and become
the best that you can be. On this journey of personal growth, you will discover that there is
much knowledge and wisdom to be gained – insights about yourself, about others, about life
and about things around you. Let us begin this journey of learning with joy.

The new course has been designed to equip you with values, attitude and behavior for sustainable
employability. Nineteen lessons in four modules will take you through the path of building
aspirations, practicing communication skills, negotiating the world of web and leaning the
intricacies of entrepreneurship. All the lessons are related to life experiences.The lessons will
equip you with the skills of responding to challenging situations in logical, sensitive and
positive ways without harming self and society and optimizing opportunities.

These life skills enriched materials aim at empowering you to enhance not only your academic
but also personal and social competencies. Along with subject knowledge, you would have the
ability to discriminate between right and wrong and take the correct decision regarding your
life and career.

During the course of study, you will find a number of activities, including intext questions, in
the lessons. Do make a sincere effort to attempt them. While activities have been carefully
designed to provide you an opportunity to learn and practice, the intext questions and Tutor
Marked Assignments (TMA) help you assess the extent of your learning. Attempting these will
aid in developing life skills without any extra effort.

You would also have to make a portfolio that will be evaluated in practical examinations. The
activities of portfolio are built from first lesson onwards. To know what is expected of you,
read the curriculum and sample question paper given at the end of your study materials.

I hope you will find these life skills enriched study materials rewarding and helpful in your
personal and professional life.

Chairman, NIOS



Congratulation! You have accepted the challenge to be a self-learner. NIOS is with you at every
step and has developed the material “Employability Skills” with the help of a team of experts,
keeping you in mind. A format supporting independent learning has been followed. If you
follow the instructions given, then you will be able to get the best out of this material. The
relevant icons used in the material will guide you. These icons have been explained below for
your convenience.

Title: will give a clear indication of the contents within. Do read it.

Introduction: This will introduce you to the lesson linking it to the previous one.

Objectives: These are statements that explain what you are expected to learn from
the lesson. The objectives will also help you to check what you have learnt after you
have gone through the lesson. Do read them.

Notes: Each page carries empty space in the side margins, for you to write impor-
tant points or make notes.

Intext Questions: Very short answer self check questions are asked after every
section, the answers to which are given at the end of the lesson. These will help you
to check your progress. Do solve them. Successful completion will allow you to
decide whether to proceed further or go back and learn again.

What You Have Learnt: This is the summary of the main points of the lesson. It
will help in recapitulation and revision. You are welcome to add your own points to
it also.

Terminal Exercise: These are long and short questions that provide an opportunity
to practice for a clear understanding of the whole topic.

Do You Know: This box provides additional information. The text in boxes is
important and must be given attention. It is not meant for evaluation, but only to
improve your general knowledge.

Answers : These will help you to know how correctly you have answered the
questions.

Activities: Certain activities have been suggested for better understanding of the
concept.

www Web site: These websites provide extended learning. Necessary information has
been included in the content and you may refer to these for more information.

How to use the Study MaterialHow to use the Study MaterialHow to use the Study MaterialHow to use the Study MaterialHow to use the Study Material
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Working Smart: Introduction to Computers MODULE - III
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Going Digital

9

WORKING SMART:
INTRODUCTION TO

COMPUTERS

We are surrounded by technology. The world is shrinking due to technological
advancements. To match with the pace of growth, one needs to remain updated.
It becomes important to be familiar with the tools and components of technology
that are being used these days. In this lesson, we will discuss about the basics
of computer and learn to work smart. Sit back, relax and let us begin the journey
to become smart.

   

Fig. 9.1: Smart Work vs. Hard Work

OBJECTIVES

After studying this lesson, you will be able to

explain the difference between hardware and software;

categorize software; and

work on a word processing software.
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Going Digital 9.1 GETTING TO KNOW YOUR COMPUTER

As we know, a computer is a combination of hardware and software. Both are
equally important to operate the computer. Let us know more about them.

1. Hardware – Hardware refers to the physical parts of the computer. Every
component (internal and external) that can be touched is called Hardware.
You must have heard words such as mouse, speakers, motherboard, hard
drive and so on. All these are examples of hardware. They are further divided
into three categories:

(i)  Input devices that are used to give information to the computer

(ii) Processing device that work on the information given by the user

(iii) Output devices that give the result back to the user

Fig. 9.2: Computer Hardware-Input /Output Devices

2. Software – Software is commonly defined as a set of instructions
or programs instructing a computer to do specific tasks. Unlike hardware,
software cannot be touched but is visible and we can work only become
of them. For example, games, MS Word, Oracle ERP, SAP, Adobe
Photoshop, Corel Draw and others. They are further classified into two
categories as follows:

(i) System software

(ii) Application software

We will discuss about these as we progress.
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Going DigitalActivity 9.1. You must already be familiar with computer and its parts. Solve
the crossword puzzle using the hints given below. All the best!

   1    9  10   

 2         11  

           12 

   3         

            

4     5       

 6           

  7     8     

Fig. 9.3: Crossword Puzzle

          ACROSS DOWN

1. The output device used to 2. A portable micro-computer.

listen to the sounds. 9. The input device used to type

2. A type of fast and noiseless  the characters and numbers.

printer. 10. A primary storage unit, to store

3. A secondary storage device, the application we are currently

capable of storing up to 700 MB. working up on.

4. A permanent primary storage unit. 11. The input device used to point things

5. The input device used to generate on the screen.

 the soft copy from a hard copy. 12. A storage unit capable of storing up

6. The output device used to get a print. to  25 GB.

7. The processing unit of computer

system

8. A secondary storage device,

capable of storing up to 4.7 GB.
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INTEXT QUESTIONS 9.1

1. Choose the correct option:

(i) Which of the following is an output device?

A. Microphone B. Monitor

C. UPS D. CPU

(ii) Identify the input device in the following.

A. Speaker B. Hard Disk

C. Scanner D. Motherboard

2. Mark the following statements true or false. Correct the false statements.

(i) Input devices are used to give the result to the user.
________________________________________________________

(ii) Hardware refers to the physical parts of computer.

________________________________________________________

(iii) Software is visible and can be touched physically.

________________________________________________________

3. Rajat has bought a new computer. He believes that the keyboard is directly
connected with the monitor, because the characters he types on it, gets
displayed on the monitor fast. Do you think he is correct? Write the correct
statement if you think his belief is wrong.

___________________________________________________________

___________________________________________________________

___________________________________________________________

9.2 TYPES OF SOFTWARE

As we have discussed in the previous section, software is a set of programs.
But what is a program? Let us understand it through an example in Figure 9.4.

A father is telling his daughter to enquire about certain things before enrolling
in a course. In the same way, if a person instructs a computer to do a specific
task, it is called programming. Hence, a program is a set of instructions given
to a computer. A set of programs makes software. As mentioned in the previous
section, software is of two types, System Software and Application Software.
Let us know more about them.
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Fig. 9.4: Understanding Programming

9.2.1 System Software

The term ‘System Software’ refers to the set of programs, which are responsible
for the functioning of a computer. Even if we purchase all the parts of the
computer, assemble them and connect it
with a source of power, it won’t work.
Do you know why? It is the system
software that “makes it work”! Operating
system, device drivers, utilities software
and other software programs, come
under the category of system software.
Let us know more about them.

1. Operating System: It is the principal software, which is responsible to
manage or operate all other software and hardware. It is usually the first
software to be installed in a system. For example, Microsoft’s Windows,
Apple’s Macintosh and others. Every computer runs on an operating system.

It is further categorized on the basis of functionality:

Single-User Operating System: A single user is able to work on it at
a given A time. For example, DOS, Windows 95 and others.

Did you know?

Mobiles and tablets also work on
specialized operating systems such as
Android by Google, iOS by Apple
etc.
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Going Digital Multi-User Operating System: Multiple users are able to work on it at
a given time. For example, Linux, Unix and others.

The users can choose any operating system as per their requirement. Let
us move further with other system software.

Operating System Device Drivers Utilities Software

Fig. 9.5: Types of System Software

2. Device Drivers: They are installed in the computer to make hardware work.
They enable hardware to communicate with each other and with the
operating system. The drivers instruct the hardware to do their jobs. For
example, to install a printer, a CD containing required drivers needs to be
run to make it functional.

3. Utilities Software: This category of software is used to support the
functioning of computer in various aspects. The Utilities Software is meant
to help the users in various tasks, such as keeping the backup of the data,
protecting the system from virus, increasing the speed of the computer and
others. Examples of such software are Anti-virus software, Disk Defragmenter,
Disk Cleaners and others.

9.2.2 Application Software

The application software is designed to fulfil a specific task or a function. They
are called as end-user programs, since they directly help the user in an activity.
Spreadsheet software like Microsoft Excel, Open Office Calc, Word Processing
Software such as Libre Office Writer, Microsoft Word, various games, browsers
and others are examples of application software. In the next section, we will
discuss about the application software called Microsoft Word.

Fig. 9.6: Application Software
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Fig. 9.7: Hierarchical Presentation of Software

Activity 9.2

Rohit is a bit confused; he doesn’t know which CD to put in which box. Please
help him sort his CDs as per the labels given on the boxes.

Box No. : Box No. : Box No. : Box No. :

Box No. : Box No. : Box No. : Box No. :

Box No. : Box No. : Box No. : Box No. :

A B C D

E F G H

I JJ K L
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Box 1: Application 
Software

Box 2: Device 
Drivers

Box 3: Utilities 
Software

Box 4: Operating 
System

INTEXT QUESTIONS 9.2

1. Choose the correct option:

(i) Which of the following is not a software?

A. Operating System

B. Games

C. RAM

D. Device drivers

(ii) Which of the following categories is most suitable for Microsoft
Windows?

A. Application Software

B. Device drivers

C. Operating System

D. Utilities Software

2. Match the following statements:

(i) Multi-User Operating System a. Windows NT

(ii) Single-User Operating System b. Software in the CD
provided with a printer

(iii) Device Driver c.   OpenOffice Calc

(iv) Utilities Software d.   Unix

(v) Application Software e.   iOS

(vi) Mobile Operating System f.   Disk Defragmenter
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Going Digital3. Kanika has recently joined a company as a computer operator. Suggest her
the appropriate software as per the following tasks given to her:

(i) To create a presentation of a product

(ii) To write a letter

(iii) To edit an image

(iv) To maintain daily records of transactions

(v) To send an e-mail

(vi) To install a scanner

9.3 INTRODUCTION TO A WORD PROCESSING
SOFTWARE

In the previous section, we discussed about the various types of software, we
shall now discuss ‘Word Processing Software’ which is used for creating basic
documents. The further discussion is based on use of Microsoft Word 2010. It
is a powerful word processing software, widely issed for documentation
purpose. Let us learn about the various components of MS-Word.

Tab

Groups

Work Area

Horizontal Ruler

Quick Access 
Toolbar

Document 
name Ribbon

Status Bar Zoom Slider 
Bar

Vertical 
Ruler

Scroll Bar

Fig. 9.8: Components of MS-Word
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In this section we will discuss about the various options related to the text,
available in MS-Word. We can open MS-Word from

Let’s understand how text can be
formatted. After opening MS-Word, we
can simply start typing to create a
document. A blinking cursor is displayed
on the top-left corner of the page,
indicating the starting point of the text.
To determine, how the text will look we
can use the options given in the Home
tab, which have been grouped under five sections. Most of the options work
only if the text is selected. Let us start discussing about the Clipboard, Font
and Paragraph group.

Fig. 9.9: Clipboard group in Home Tab

The Clipboard group consists of options
such as cut, copy and paste. As the name
suggests is used cut, copy and paste the
text and format it. It is used if the
position of the text is to be changed or
the text needs to be copied to another
location within the document. The Format Painter copies the formatting of the
selected text and applies it on another piece of text.

Fig. 9.10: Font group in Home tab

Did you know?

To open MS-Word with a keyboard
shortcut, press Start button + R key.
Type ‘winword’ in the Run window and

press the Enter key

Did you know?

When the cursor is brought over an
option in the Ribbon, it displays the
option’s name, use and its shortcut.
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Going DigitalThe Font group gives a selection of options to format the font to customize
the text as per the requirement.

Table 9.1:  Let’s see how various options work ions in Font group

The font style changes to this.

Increases or Decreases the font
size like this

Changes the case from THIS to
This or tHIS

Bold, Italic, Underline, Strikethrough

Subscript: H2O Superscript: a2

Visual Effects, Highlighted Text,
Changed Colour

Clears the formatting from THIS
to THIS

Fig. 9.11: Paragraph group in Home tab

The Paragraph group consists of the options related to formatting of a paragraph
or a list. The text alignment options, indentation, text borders and other options
are part of this group. To understand these options better, let’s go through the
Table 9.2.
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Going Digital Table 9.2: Examples of options in Paragraph group

These options are used to create lists as follows:

Bulleted: Numbered: Multilevel:

A 1. A 1. A

B 2. B    1.1 B

C 3. C    1.2 C

D 4. D 2. D

They change the alignment/position of text:

Line-spacing:

Increase or Decrease the Indent(space from margin)

Sorts the text alphabetically or numerically

When turned on, it shows paragraph marks and
other hidden symbols, like this:

This is Left Alignment. This
is Left Alignment. This is
Left Alignment. This is Left
Alignment. 

This is Right Alignment. This
is Right Alignment. This is

Right Alignment. This is
Right Alignment.

This is Justified Alignment. This
is Justified Alignment. This is
Justified Alignment. This is
Justified Alignment. This is

This is Center Alignment. This
is Center Alignment. This is

Center Alignment. This is

Center Alignment.

Spaces between the lines.
Spaces between the lines.

Spaces between the lines.

Spaces between the

Colours the background of text like this.

Gives borders around some text like this.

Decrease Indent of a
paragraph like this.
Decrease Indent of a

paragraph like this.

Increase Indent of a
paragraph like this.
Increase Indent of a

paragraph like this.

6

2

4

2

4

6
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Going DigitalActivity 9.3

You have learned about the importance of having a CV in chapter 8. It is a
reflection of one’s work, attitude and personality, therefore it is equally
important for an employee as well as an employer. It tells the employer about
the fitment and for employee it is a reflection of their work and achievements.
In today’s digital world it is important to have a digital copy of one’s CV, let’s
try a create one for our self.

Observe the following formats of CV and cover letter and write yours in the
word format (Using MS-Word). Your CV must have the following fields: name,
date of birth, address, e-mail id, qualification, experience, references and others
save a copy for your reference.
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12/1 NS Road, 10th Floor, Chennai-602412

Contact: +91-987654321

Email: venu@gmail.com

Respected HR Team,

I am submitting here with my resume for your perusal and favourable consideration to
work in your organisation.

Review of my credentials indicates that I am a qualified B.E. (COMPUTER SCIENCE)
from Adhi College of Engineering and Technology, Kanchipuram (Chennai) affiliated
to ANNA UNIVERSITY; possess rich domain knowledge with comprehensive
understanding of JAVA, JAWA, HTML, C++.

Exceptional communication and interpersonal skills, confidence, innovative approach
and quick adaptability to changing processes and trends have been my biggest assets.

I am seeking a challenging job that would match my skills and experience with the
objectives of the organisation. The above credentials along with my enclosed resume
make me ideally suitable for a position in your organisation. I would appreciate an
opportunity for a personal interview.

Thanking you in anticipation of a favourable reply.

Yours sincerely

Venu Gopal

9.3.2 Inserting Objects

In the previous section, we discussed about working with the text and now we
will learn about inserting various objects in the document, such as pictures,
tables, charts, shapes and others. In this section we will look at various options
available in the Insert tab.

1. Inserting Tables

Tables are considered as the most
systematic way to enter and store
data. In MS-Word, a table can be
inserted using the Insert tab → Tables
group → Table option.

Did you know?

The drop-down arrow ( ↓ ) after  every
option’s name indicates that there are
further hidden options inside it.
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Method 1: Using the Grid

Method 2: Using Insert 

   Table

Move the cursor over 
this grid to select the 
number of rows and 
columns. In this example, 
3x3 refers to 3 rows and 3 
columns, indicated with 
orange colour.

Method 3: Using Draw 

    Table 

Click on this option 
and enter the desired 
number of rows and 
columns to insert a table

Click on this option. 
The cursor changes 
into a pencil icon. 
Drag it on the page 
and draw the table 
as required.

Method 4: Using Quick 

    Tables 

This option provides the 
built-in tables, which 
could directly be 
inserted in the 
document and modified 
later.

Fig. 9.12: Inserting Table

When a table is inserted, two other tabs appear under the Table Tools tab, Design
tab and Layout tab. These tabs give options to modify the table. We can format
the table, design it, insert/delete rows/columns, merge or split the cells, change
the alignment of the text in the table, use formula and others. Thus all the options
to modify a table can be found under these tabs.

2. Inserting Picture, Clip Art, Shapes and SmartArt
These objects are used to represent the data in a distinct manner. These
options can be found in the ‘Illustrations group’ of the Insert tab. When any
of the objects is inserted in the document, another tab called Format appears
in the Ribbon, it is used for arranging and structuring the objects that have
been inserted
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Click on this option to insert 
a Clip Art. Type a keyword in 
the searching pane which 
appears on the right of the 
screen, click on the desired 
Clip Art to insert. 

Click on this option to insert 
a picture. Select the desired 
picture, when the dialog box 
appears

Click on this option to insert a 
shape. Select the required 
shape and drag the mouse 
on the page to draw it.

SmartArts are diagrams or graphics, 
used to explain complex data in an 
easier way. Click on this option to 
insert a SmartArt graphic. Select the 
desired type and design, and type 
the required data in the graphic.

Fig. 9.13: Inserting Picture, Clip Art, Shapes and SmartArt graphics

3. Inserting Charts

A chart is a pictorial representation of data. It makes data easy to analyse,
compare and understand. This option is also available in Illustrations group
of Insert tab.

When we click it, a dialog box appears. We can select the desired chart type
from it and lock it. Then we click ‘OK’.

Fig. 9.14: Insert Chart dialog box
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Fig. 9.15: Entering data for a chart

Another window of MS-Excel also opens automatically. This window is called
Datasheet, and we enter the data of the chart in the Excel sheet and then close
it after completion of data entry. The chart will be displayed in the MS-Word
window.

The chart will get updated automatically, whenever data is updated in the
worksheet. When a chart is inserted, three additional tabs appear under Chart
Tools tab, that is Design, Layout and Format.

4. Inserting Hyperlink\\
Hyperlinks are used to link a piece of text in a document with a web address
or a file in the computer. This makes it easy to access a file/web page, as
its link would be available in the document that we will be currently working
on. This option is found in the Links group in the Insert tab.

Click on the text, with which the link has to be created. Open the dialog box, as 
mentioned above, refer to figure 9.16. Select the web page / file to be linked with the 

text, click on Ok. The text will get underlined in blue, thus a link is form.

Fig. 9.16: Insert Hyperlink dialog box
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You must have observed in books, that there is some text which is usually
repeated at the top or bottom of the page. They are simply typed once using
the command Headers and Footers. These are used to display some
information on every page, such as page number, date/time, chapter number,
chapter name and other information. The difference lies in the fact that
header appears at the top and footer appears at the bottom. This option is
found in Header & Footer group of the Insert tab. When Header/Footer is
inserted, an extra ‘Design’ tab appears in the Ribbon under Header & Footer
tools tab. It consists of the options to modify the Header & Footer.

Select the desired style of Header & Footer and 
type the required text. It will appear on every page.
To modify the Header/Footer, double-click on the 
Header/Footer area, and make the desired changes.

Fig. 9.17: Insert Hyperlink dialog box
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Textboxes are the mediums in MS-Word through which, we can portably
write text at any place. The text written in a Textbox can be moved to
anywhere in the document, without interfering with the appearances of the
text inside it. The option to insert a Textbox is found in Insert → Text →
Textbox. When a Textbox is inserted, an extra ‘Format’ tab appears, which
consists of the options to format the Textbox, and its contents.

There are many other options available in the Insert tab, such as WordArt,
Symbol, Drop Cap, Signature Line, Cover Page and others. We will suggest
you to go through and practice all of them.

7. Inserting Table of Contents
Table of Contents include the details of the contents added in a document.
It is usually inserted at the starting of the document since it works like an
‘index’ which summarizes the entire document in a page. This option is
available in Table of Contents group in the References tab.

Select the desired style of Header & Footer and type the required text. It will 
appear on every page. To modify the Header/Footer, double-click on the 

Header/Footer area, and make the desired changes.

Fig. 9.18: Inserting Table of Contents
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Activity 9.4

Healthy and disciplined routine is the key to success. One should have a
disciplined routine and stick to it. Create a table in MS-Word, and fill the details
of your present routine in it. Reflect on it to see how healthy is it and what
can you do to improve it further. The table must have the following columns:
Task, Approximate Time Duration (in hrs).  Also, create a chart using the same
data.

9.3.3 Page Layout

In the previous sections, we have discussed about inserting and working with
text and various graphics, but their appearance is depend on the basic layout
of the page. In this section, we will discuss about basic components which affect
the appearance of the text and objects with respect to the pages.

1. Setting Margins, Orientation and Size

The above options are available in Page Setup in Page Layout tab.

Margin refers to the distance between the text and t
he edges of the page. Select the desired margin 

from Normal, Narrow, Wide, Mirrored, Custom etc., 
after clicking on this option.

The Orientation of the page is simply its layout. 
It is of two types, Portrait (Vertical Layout of the page) 

and Landscape (Horizontal Layout of the page). 
Click on this option to choose between the two.

It directly refers to the Page Size. MS-Word 
lets us create the documents on any size to 
be chosen from A4, A3, Legal, Letter etc. 

Click on this option to choose the page size.

Fig. 9.19: Setting Margins, Orientation and Size

Did you know?

Rand( ) function inserts some random text in a fresh blank document. To try it write ‘=rand
(No. of paragraphs, No. of lines in each paragraph)’. For example, =rand(4,5) will insert
4 paragraphs, with 5 lines in each paragraph.
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Borders provide a complete look to the document. We can apply borders
to MS-Word document also, to do so, click on the Page Layout ’! Page
Background ’! Page Borders. Select the desired options in the Borders and
Shading dialog box.

Fig. 9.20: Borders and Shading dialog box

Activity 9.5

Diary writing is believed to be a stress-relieving task. Let’s create an eco-friendly
diary, which saves paper. Create a document in MS-Word and perform the
following tasks in it:

1. Insert a Table of Contents at the starting of the document

2. Insert Header and Footer, where the Header should display your name and
Footer should display the page number

3. Set the margins to 2” from each side

4. Set the page size to A3

5. Set the orientation to Landscape

6. Apply page borders

Once you are done, save the document as “My Digital Diary”, and write your
experiences in it.
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Imagine that you are planning to celebrate your birthday, design an invitation
card in MS-Word. One of your friends suggests that rather than writing the
names of your friends on each card, the printed ones will look smarter. But typing
every name individually on each card will be a time consuming task! MS-Word
has an excellent feature to fulfil this plan, called as Mail Merge.

Mail Merge is a powerful feature, which reduces the effort by creating list of
recipients and customizes the information for each person, on a different page,
in a directly printable form. This feature can be found in Mailings tab. Different
options are used from various groups to complete the merging of mails.

To start Mail Merge, click on Start Mail Merge in the Mailings tab and select
the type of document to be created. Here we will select ‘Letters’.

Fig. 9.21: Starting Mail Merge

Type the content and select the recipients list as shown in Figure 9.22

Fig. 9.22: Selecting recipients in Mail Merge
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dialog box appears when we click on ‘Type New List…’ option. Click on
‘Customize Columns…’ to add, delete or rename columns. Click on New Entry
or Delete Entry to enter or delete a record. Enter the required data and press
Ok. MS-Word will ask you to save the list. Save it with a meaningful name.

Fig. 9.23: Entering Data of Recipients

Insert the fields as shown in Figure 9.24

Fig. 9.24: Entering Fields

Click on Finish & Merge and select the desired options in the further dialog
boxes. The Mail Merge feature generates a new document, merging the
recipients list and the letter together in it, as shown in Figure 9.24.
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i Kiran

23456789

am going to celebrate my
rthday on 10th December.
indly join us, we will have

Hi Manoj

987654321

I am going to celebrate my
birthday on 10th December.
Kindly join us, we will have

I am going to celebrate my
birthday on 10th December.
Kindly join us, we will have

Hi Ajay

123958746

Fig. 9.25: Completed Mail Merge

Activity 9.6

Design your birthday invitation card, as given in the figure below. It has been
designed in MS-Word, using only the components discussed in this chapter. Go
through the details to find it!
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You must have created your CV and cover letter in the Activity 9.3. Customize
the cover letter for five different companies, using Mail Merge. It must have
the company’s name, address and contact number at the top, though the rest
of the content will remain same.

INTEXT QUESTIONS 9.3

1. Choose the correct option:

(i)  Which of the following is not the name of a tab in MS-Word 2010?

A.  Insert

B.  Mailings

C.  Home

D.  Clipboard

(ii)  Which tab consists of the option to insert the Table of Contents?

A.  Home

B.  References

C.  Page Layout

D.  Insert

2. Match the following statements:

(i) A.   Bullets

(ii) B.   Mail Merge

(iii) C.   Insert Table

(iv) D.   Superscript

(v) E.   Underline

(vi) F.   Justify Alignment

(vii) G.   Insert Shapes

(viii) H.   Orientation
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Suggest any five features available in MS-Word, using which she can beautify
the document.

4. Identify the features of MS-word, required in the following situations:

(i) To create multiple copies of a letter customized for different people.

(ii) To write the chemical formula of Carbon Dioxide.

(iii) To put a symbol before every sentence in a list.

(iv) To denote some information through graphics.

(v) To display the same text on every page.

WHAT YOU HAVE LEARNT

Computer
System

Hardware Software

Single-
User

Multi-
User

Home
Tab

Clipboard Group,
Font Group and

Paragraph Group
(Font related
formatting)

To insert Table,
Picture, Clip Art,

Shapes, Smart Art,
Chart, Text Box,

Hyperlink, Header
& Footer

Page related
formatting

(Setting Margins,
Orientation, Size,

Applying page
Borders)

Inserting 
Table of 
Contents

Mail
Merge

Insert
Tab

Page Layout
Tab

References
Tab

Mailings
Tab

ApplicationSystem

MS-Word
2010

Device
Drivers

Utilities
Software

Operating
System

TERMINAL QUESTIONS

1. Write any two differences between Hardware and Software.

2. Name and explain the types of Software.

3. Explain the use of word processing software.
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to take out a print, but failing to do so. Explain the possible reason for this.

5. Differentiate between Chart and SmartArt Graphic. Which of these should
be used, if some numerical data has to be compared and analyzed?

6. Which category of hardware devices, does CPU fall in? Explain with a
reason.

7. Define the Mail Merge feature.

8. In the follo wing table, the Tab name or the Group name is missing for the
given options. Fill in the correct information to complete the table:

TAB  GROUP OPTION

Home     

   Links     

Page Background      

  Mailings      

   Insert    

ANSWERS TO INTEXT QUESTIONS

9.1

1. (i) B. Monitor

(ii) C. Scanner

2. (i) False, Output devices are used to give the result to the user.

(ii) True

(iii) False, Software is visible but cannot be touched physically.

3. He is not correct. The keyboard and the monitor are both connected with
CPU, and they are not directly connected with each other.

9.2

1. (i) C. RAM

(ii) C.  Operating System
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(ii) Single-User Operating System : Windows NT

(iii) Device Driver : Software in the CD provided with a printer

(iv) Utilities Software : Disk Defragmenter

(v) Application Software : OpenOffice Calc

(vi) Mobile Operating System : iOS

3. (i) A presentation software: Libre Office Impress or MS-Powerpoint etc

(ii) A word processor: OpenOffice Writer or MS-Word etc

(iii) An image editing software: Adobe Photoshop or Gimp etc

(iv) A spreadsheet software: MS-Excel or Libre Office Calc etc

(v) A browser: Internet Explorer or Google Chrome etc

(vi) Its device driver

9.3

1. (i) D. Clipboard

(ii) B. References

2. (i) → Superscript

(ii) → Underline

(iii) → Bullets

(iv) → Justify Alignment

(v) → Insert Table

(vi) → Insert Shapes

(vii) → Change Orientation

(viii) → Mail Merge

3. Text Effects, Font Styles, Font Size, Font Colours, Bullets, Page Borders,
Inserting Graphics (Shapes, Clip Arts, Charts etc). She can format the
graphics also.

4. (i) Mail Merge

(ii) Subscript

(iii) Bullets

(iv) SmartArt Graphics, Charts etc

(v) Header or Footer
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Dear learners, you have learnt the basics of computers in the previous lessons.
In this lesson you will learn how to use this skill to analyse your work as an
entrepreneur. You must have seen some people who have become financially
successful while some who have remained at the same level in spite of hard work.
Have you ever wondered why? Successful people regularly analyse their work
including time, money and the energy spent. These calculations can be done by
using a paper and pen. But when there are too many calculations, the probability
of errors increase. In this lesson we will learn about Spreadsheets which will
simplify the process of calculating and analysis. We would also learn about visual
presentation of your work.

OBJECTIVES

After studying this lesson, you will be able to:

create a spreadsheet by using functions, formulae and various referencing
techniques;

create a spreadsheet by freezing pane for entering data; and

analyse the data using filter, sort, validation checks, conditional formatting,
charts, pivot table.

10.1 CRUNCHING NUMBERS USING SPREADSHEET

A spreadsheet is a tool for storing data in tabular form consisting of rows and
columns. Data is entered in cells of a table. Each cell may contain either numeric
or date or text data. Results of formulas that are automatically calculated can
also be displayed in a cell. Do you know that if we change a value of a particular
cell, changes are automatically reflected in other cells in reference to that cell?
Doesn’t it make your work simpler? Let us learn how to create a spreadsheet.

10

SPREADSHEETS
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In this section we will be learn some of the features of MS Excel 2007. You
have already learnt about opening the word processor. For MS Excel you need
to go to

Start ’!

All Programs ’!

Microsoft Office ’!

Microsoft Office Excel 2007

The spreadsheet can be created by clicking on the Microsoft Excel 2007 icon
in the start menu. The opened spreadsheet is shown in figure 10.1.

Fig. 10.1: Spreadsheet

An opened spreadsheet consists of following:

Column Name: Each column has a capital English alphabet such as A, B,
C and so on at the top.

Row Number: Each row is indicated by a number to the immediate left of
the first column such as 1, 2, 3 and so on.

Each cell has unique address consisting of the column letter followed by the
row number. For example, the address of the cell in the third column, third
row is C3. The user has to enter the data in it.

A worksheet is a single spreadsheet which contains cells organized in a
tabular form consisting of rows and columns.
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Each new opened spreadsheet contains three blank worksheets: Sheet1, Sheet2
and Sheet3. We can rename or add more sheets as per our requirement. For
working, a particular sheet is selected by clicking on the icons as shown in figure
10.2. The sheet which is active is displayed in bold and it appears that its tab
is on top of others sheets.

On the Left bottom of the spreadsheet, four scroll buttons appear: First sheet,
Previous sheet, Next Sheet and Last Sheet. It is followed by the active worksheet
tabs in a spreadsheet and the Insert worksheet Button. You can insert more
worksheets by clicking the insert worksheet button that appears immediately to
the right of the last worksheet tab.

Fig. 10.2: Different sheets in a Spreadsheet

Activity 10.1

Topo is working as a Team Leader in a company. He wants to quit his job and
open his own company. Unfortunately, he does not have any computer
background. He has listed his total salary and deductions, current expenditures
and savings. Help Topo to enter the following data in 3 tables of spreadsheet:
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Total Salary 25000
Deductions (PF, Tax, etc) 5000

Current Expenditures (pm)

House Loan EMI 5000

Bike/ Loan 2000

School fees of children 2000

Monthly Utility bills (electricity, water, gas, etc) 1500

General expenditure (food, entertainment, 5000

conveyance, medical)

Misc Expenditures 2000

Insurance policies (Life and mediclaim) 500

Savings

Fixed Deposits 50000

Provident Fund Account 75000

Saving Account 10000

Now that you have entered the data, check if all the data is reflected in the sheet.

3.  Referencing Techniques

Cell referencing techniques play an important role in creating formulas in
spreadsheets. It allows your formulas to update automatically if the value of
a particular cell changes. It also assists in updating formulas as cells are copied
or moved. In spreadsheet, we have two types of referencing techniques:

1. Relative

2. Absolute

These techniques behave differently when copied to other cells. All cell
references are relative references by default.

1. Relative: It changes when a formula is copied to another cell. For example,
if you copy the formula =A3*B3 from row 3 to row 5, the formula will
become =A5*B5. It is used when you want to repeat the same calculation
across multiple rows or columns.

2. Absolute: It does not change when copied or filled. It is used when you
want a row and/or column value to be constant. It is indicated by adding
a dollar sign ($) before either the column or row location or both.
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column and relative row.

The examples of above techniques are shown below:

Relative (A1): The column A and the row 1 changes when copied.

Absolute ($A$1): The column A and the row 1 do not change when copied.

Mixed (A$1): The row 1 does not change when copied.

Mixed ($A1): The column A does not change when copied.

4. Using Existing Functions

Let us see how you can use the existing functions to calculate. Existing functions
are like built-in formulas that perform calculations using specific values in
selected cells. Some of the basic functions are:

SUM for summing up numbers

AVERAGE for calculating an average

COUNT for counting the numbers

MAX for identifying the largest number

MIN for identifying the smallest number in a range of selected cells

Functions are used for handling different needs: working with numbers, text,
date, time or financial calculation. Using existing functions saves time since we
do not have to write the formula ourselves. The function has a specific syntax
that has to be followed to work correctly. Syntax is a set of rules for the
structuring of statements. The syntax of a function has the following order:

All functions begin with ‘=’ sign.

Mention the function name after = sign (for example, count).

The parameter list which contains the cell range or cell references is
enclosed by parenthesis. Each parameter is separated by a comma.

An example of a summation function (SUM (B2:B7)) with one parameter that
sums a range of cells B2 to B7 is shown in figure 10.3:
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Fig. 10.3: Using Summation function in a spreadsheet

Calculation of sum of range of data can be done by using AutoSum as follows:

1. Select the formulas tab

2. Select the cell where you want to use the function; in this example it is B8

3. Select the AutoSum and then Select SUM.

4. A formula will appear in selected cell B8. The function is = SUM (B2:B7).
The AutoSum automatically selects the range of cells from B2 to B7. The
cell range can also be altered by changing cell numbers.

5. The total sum will appear after entering Enter button (as in figure 10.4).

Fig 10.4: Using AutoSum in a spreadsheet
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After entering all the major financial data in Activity 10.1, now Topo wants to
know his total outgoing expenses, net income and total savings.

Help Topo calculate the above by doing the following things:

Take your mouse cursor below all the 3 tables created in Activity 10.1.

Then, insert a new row by clicking the Insert icon on the Home tab and
then selecting Insert Sheet Rows.

Label the cells as  Total_Net_Income, Total_Outgoing_Expenditure,
Total_Savings.

Make a function to calculate the Total_Net_Income (that is, Total Salary-
Deductions).

Use SUM function to calculate the Total_Outgoing_Expenditure.

Use SUM function to calculate the Total_Savings.

5. Creating formulas

Creating a formula in a cell requires the calculations to be performed in order
to get a value. It can combine the results of two or more different existing
formulas also. Consider the following example in which the total cost of
purchasing has to be calculated.

Fig. 10.5: Creating formulas
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Cost of different items purchased has to be calculated by multiplying price
of item and quantity purchased i.e., D3=B3*C3 (see figure 10.6), etc.

Fig. 10.6: Calculating cost

Total Cost has to be calculated by summing cost of all items in D9 cell by
using function SUM (D3:D8) (see figure 10.7)

 

Fig. 10.7: Calculating Total Cost

The total cost is displayed in D9 cell as 422 in this example.



 37

Spreadsheets MODULE - III

Notes

Employability Skills

Going DigitalActivity 10.3

After calculating Net incoming salary, total outgoing expenses, and total savings
in activity 10.2, now Topo wants to know his total net income left in his hand
per month. Help Topo calculate the above by doing the following things:

Write a function which calculates the net income in a new cell by subtracting
Total_Outgoing_Expenditure from Total_Net_income.

Select a cell at appropriate place for labelling the above cell.

6.  Freeze Pane

This feature allows you to freeze portions of a worksheet, typically column and
row headings, so that you can view and enter the data in distant parts of the
worksheet while the headings remain in place.

The freeze panes in a worksheet can be done by positioning the cell cursor as
follows:

Rows: Select the row below the rows you want to freeze. For example, to
freeze rows 1 and 2, click row 3.

Columns: Select the column to the right of the columns you want to freeze.
For example, to freeze column A and B, click column C.

Columns and rows: Click the cell below the rows and to the right of the
columns you want to freeze. For example, to freeze both column C and row
3, click cell D4.

Freeze Panes: Select Freeze Panes in the View tab, and then click Freeze Panes.
A thin black line separates the sections. As you scroll down and to the right, notice
that the columns above and rows to the left of the cell cursor remain fixed. An
example to freeze first column A and first 2 rows is shown in figure 10.8:

Fig. 10.8: Freeze Panes
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Panes. It unlocks the fixed rows and columns as in figure 10.9.

Fig. 10.9: Unfreeze Panes

INTEXT QUESTIONS 10.1

Find out what went wrong in the steps. Write the correct steps:

1. Iqbal wanted to start a new spreadsheet. He clicked Start →
Microsoft Office →  All Programs →  Microsoft Office Excel 2007 → File.

Ans: Iqbal should have clicked ___________________________________

____________________________________________________________

2. Mixed Referencing: While referencing Satbir did not want the contents of
row 10 to change while copying the contents from B column, so he used
the formula ($B10)

Ans: Satbir should have _________________________________________

____________________________________________________________

3. Formula: Juhi wants to add all the data from C2 to C10 cell in C11 cell,
she has calculated the sum by mentioning C2 + C3 + C4 + C5 + C6 + C7
+ C8 + C9 + C10

Ans: Juhi should have used  ______________________________________

____________________________________________________________

10.2 ANALYSING DATA USING SORT, FILTER,
CONDITIONAL FORMATTING

Once the data has been input, it is ready to be analysed. In this section you will
learn how the sorting, filtering and conditional formatting is done on the data.



 39

Spreadsheets MODULE - III

Notes

Employability Skills

Going Digital1. Filtering Data

Filtering is a method of locating and managing data in a spreadsheet. It is applied
when we want to display some specific data instead of the entire data. Filtered
data can be copied, manipulated, and printed without moving it to a new
spreadsheet.

a. Select the column to which you want to apply the filter. If you want to apply
filter on all columns, then select the row consisting of column labels of your
data. We have selected second row for applying filter.

b. Select locate the Sort & Filter group from the Data tab, then click the Filter
Icon.

Fig. 10.10: Filtering data

c. Drop-down arrows will appear in the header of each column.

d. Filtering of a column can be done by clicking the drop-down arrow. In this
example, we’ll filter the Item column to view only certain types of Item.

Fig. 10.11: Filter menu
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f. Uncheck the boxes next to the data you don’t want to view in the result
or uncheck the box next to Select All to quickly uncheck all.

g. Check the boxes next to the data you do want to view. In this example, we’ll
check Item-2 and Item-4 to view only these items (see figure 10.12).

Fig. 10.12: Applying Filter

h. Click Ok. All other data will not be visible, or temporarily hidden. Only Item-
2 and Item-4 will be visible (see figure 10.13).

Fig. 10.13: Filtered data

You can also apply another filter on above data to narrow down results.

2.  Sorting Data

Sorting allows you to reord data in a worksheet. The common type of sorting
is alphabetical ascending or descending ordering. You can sort data by numbers
(smallest to largest or largest to smallest), text (A to Z or Z to A), dates and
times (oldest to newest and newest to oldest) in one or more columns. The
sorting of data can be done as follows:

a. Select the cells of a column you want to sort.
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To sort in ascending order, click A to Z icon in worksheet. It sorts A
to Z or smallest number to largest.

To sort in descending order, click Z to A icon in worksheet. It sorts
Z to A or largest number to smallest.

For sorting multiple levels, click in the Sort & Filter group of the Data tab
and do the following:

c. Click the Sort icon to open the Custom Sort dialogue box (see figure 10.14).

Fig. 10.14: Custom Sort dialogue box

d. Choose one of the options after clicking the drop-down arrow in the
Column Sort by field.  Let us select “Cost” column (see figure 10.15).

Fig. 10.15: Drop down menu of custom sort
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as Value.

f. Order the results is chosen next. Leave it as A to Z so it is organized
alphabetically.

g. Click Add Level to add another item to sort by.

Fig. 10.16: Sorting by column Cost

h. Select an option in the Column “Then by” field. In this example, we have
chosen “Price of Item”.

i. Next, you have to choose sort on. In this example, we have left the default
as Value.

j. Choose how to order the results. Order is selected as smallest to largest.

k. Click Ok (see figure 10.16).

Fig. 10.17: Sorting by column Price

l. The worksheet is sorted as follows (see figure 10.18):

Fig. 10.18: Data displayed after applying sorting on Cost and Price columns
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It is difficult to examine the raw data consisting of hundreds of rows in a
spreadsheet. Conditional formatting helps you to highlight interesting or unusual
cell values in a spreadsheet. It also helps you to visualize the data formatting
by using data bars. In conditional formatting chosen rules and formatting are
applied to one or more cells based on the value of the cell. Before choosing
a formatting rule, you must identify the questions you are trying to answer.

Conditional formatting can be applied as follows:

a. Select the cells on which you want to apply conditional formatting.

b. Click the Home tab and then locate the Styles group.

c. Click the Conditional Formatting icon. A menu will appear with formatting
options.

Fig. 10.19: Conditional formatting options

d. Select one of the Conditional formatting options to apply it to the selected
cells. A cascading menu will appear (see figure 10.19).

Different Conditional formatting options are as follows:

i. Highlight Cell Rules: This option highlights specific cells based on your
option choice. It has options like greater than, less than or equal to a number,
and between two numbers, etc. It can also be used to highlight cells that
contain specific text or date. When this option is selected, a dialog box will
appear, and then you have to mention the cell or range of cells to highlight
and the colour to be used for highlighting the cells. For example, we have
applied Greater Than 100 on the column Cost (excluding 522 value)
(see figure 10.20).
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Fig. 10.20: Applying Highlighting cells

ii. Top/Bottom Rules: This option highlights cell values that meet a specific
criteria. It has options like top or bottom 10%, above average, and below
average, etc. This option is selected, a dialog box will appear, and then you
have to mention the cell or range of cells to highlight and the colour to be
used for highlighting the cells. For example, we have applied Top 10% on
the column Cost (excluding 522 value) (figure 10.21).

Fig. 10.21: Applying Top 10% Rule
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length of the data bar represents the value in the cell. The longer the bar,
the higher the value (see figure 10.22).

Fig. 10.22: Formatting cells using Data Bars

iv. Colour Scales: This option applies a two or three colour gradient to the
cells. The shade of the colour represents the value in the cell (see figure
10.23).

Fig. 10.23: Formatting cells using Colour Scales

The conditional formatting can be removed as follows:

Click on the Conditional Formatting icon.

Select Clear Rules. A cascading menu appears.

Choose to clear rules from the entire worksheet or the selected cells.

The conditional formatting can be managed as follows:

Click the Conditional Formatting icon.
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Manager dialog box will appear.

The editing, deleting and changing the order of the rules can be done.

4.  Data Validation Checks

Data validation is the process of ensuring that correct, meaningful and useful
value of data is only entered. It uses validation rules for checking it. The
following actions can be done:

a. Determine if an entry is valid based on calculation in another cell.

b. Set a range of numeric values that can be entered in a cell.

c. Restricting the values allowed in a cell from a list of entries.

d. Create a prompt message about the kind of data allowed in a cell.

e. Create messages that appear when incorrect data has been entered.

We are aware that quantity of an item should be greater than zero. Let us make
a validation check on the quantity column as follows:

a. Select cells C3:C8.

b. On the Data menu, click Data Validation (see figure 10.24).

c. On the Settings tab, click Whole number in the Allow drop-down list.

d. By default, the Ignore blank is checked. Uncheck it.

e. In the Data, select greater than.

f. Next mention the Minimum value as 1.

Fig. 10.24: Data Validation
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You can also create an input message and error alert that appears when
incorrect data is entered (see figure 10.25).

  

Fig. 10.25: Input message and Error Alert window for Data Validation

5. Pivot Table

Pivot Tables are used to summarize, explore, analyse, and present your data in
a spreadsheet. It can be created by using a few clicks. Pivot Tables are flexible
and can help you to quickly find the answer to different questions. The pivot
table can be created as follows:

a. Select the cells in a spreadsheet that you want to use in the Pivot Table.

b. Select the Insert tab and then click the Pivot Table icon.

c. Click Pivot Table again. It selects cells in the active spreadsheet, and then
Pivot Table dialog box is opened.
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Fig. 10.26: Range of data

d. The Table/Range field shows the range of the selected data. New Worksheet
is selected by default at the place where the Pivot Table will be created (see
figure 10.27).

   

Fig. 10.27: Pivot Table

e. Each column label in your data becomes a field that can be used in
PivotTable. The Field List appears on the right side of the report, while the
layout area appears on the left.

f. The fields are selected depending upon the analysis. For example, you might
want to know the cost of each item. Then the fields that are necessary to
answer this question, Item and cost are selected by clicking check box next
to both fields.

g. The field will appear in the drag-and-drop area at the bottom of the field
list and in the layout area. By default, the data with numbers will always
appear on the right.
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Fig. 10.28: Fields of the pivot table

We can also add filter to above report by using “Report Filter” icon in the right
side (see figure 10.28).

Activity 10.4

After calculating Net income left per month in his hand, help Topo analyse the
current expenditure components where he can optimize his expenditure by doing
following things:

a. Apply the validation checks on different columns, so that only whole number
can be entered.

b. First sort the current expenditure in descending order

c. Highlight the components >= 2000 in red colour

d. Find the components having top 10% of total cost

e. Find the components having bottom 10% of total cost

f. Create the data bars for the different components in different colours

g. Select the components where expenditure can be reduced

6. Creating Charts

Charts are used to display numeric data graphically so that it becomes easier
to understand large amount of data and the relationships between data.
Spreadsheet supports many types of charts to display data which will be useful
for the user. Some of the commonly used charts are Pie, Bar, Line, Column,
Scatter (XY), Area, etc.
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in which data has been selected. The chart can be created as follows:

a. Select the worksheet to work with.

b. Select the cells including column titles and row labels from which a chart
has to be created.

c. Click the Insert tab.

d. Select the type of chart that has to be created.

Figure 10.29 shows the snapshot in creating chart for the data mentioned in the
example of section 10.1.4.

Fig. 10.29: Creating Chart



 51

Spreadsheets MODULE - III

Notes

Employability Skills

Going DigitalA chart contains different elements. When a chart is created some of the elements
are displayed by default, others can be added as needed. The display of the chart
elements can be changed by moving it to other locations in the chart, resizing
it or by changing the format. The chart elements that you do not want to display
can also be removed. Different elements of the chart are shown in figure 10.30:
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Fig. 10.30: Elements of chart

7. Analysing data

Consider the data from figure 10.8 in section 10.6.1. The total weekly budget
for purchasing items is Rs 500. But from the data, it appears that planned
expenditure is Rs 522 which is above weekly budget. The following analysis
can be done so that the expenditure is within the limits.

How much more money is spent above the budget?

Which items are expensive?

Which items are of minimum cost?

Which items are of higher priority?

The minimum number of quantity of higher priority items required for
purchase.

Which item(s) can be eliminated/reduced/added as per the requirements?

Activity 10.5

Now Topo wants to analyse his current financial situation by visualizing the
following data:

Salary and deductions components,

Current expenditures components,
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Breakup of Total_Net_income, Total_Outgoing_Expenditure, Total_Savings.

1. Help Topo to graphically visualize all above by creating appropriate charts.

2. Topo also wants to improve his financial situation by reducing
Total_Outgoing_Expenditure. Help Topo to identify the components where
Topo can reduce his expenses.

INTEXT QUESTIONS 10.2

Find out what went wrong in the following steps. Write the correct way of doing
these steps.

1. Ishan wanted to view his grades in a specific subject consisting of all subjects
grades in a spreadsheet. He has used sorting technique for it.

Ans: Ishan should have applied ________________________________

___________________________________________________________

2. Saahil wanted to change colour of the cell in which he has scored less than
30 marks for different subjects. He has used colour scales technique for it.

Ans: Saahil should have used ___________________________________

___________________________________________________________

3. Aafreen wants to display her expenditure of different items in percentage
form. She has used the bar graph for it.

Ans: Aafreen should have used __________________________________

___________________________________________________________

8. Writing Macros

A macro is a piece of programming code that runs in spreadsheet environment
and helps automate routine tasks. Macros are available in developer option.
The tab for developers is not displayed in spreadsheet by default. In order to
record macros, the Developer tab can be displayed as follows (see figure 10.31):

a. Click the Spreadsheet Options button.

b. From the Popular section, select the Show Developer Tab in the Ribbon
check box.

c. Click OK, then Developer tab appears.
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Fig. 10.31: The Developer Tab

In order to record a macro, the following steps have to be followed:

a. Select the Record Macro in the Code group of the Developer tab. The
Record Macro dialog box appears.

b. Assign a name for the macro in the Macro Name text box. The first character
of the macro name must be a letter, and the name cannot contain spaces
or cell references.

c. Assigning a Shortcut Key is optional.

d. From the Store Macro in drop-down list, select where you want to store
the macro:

This Workbook: Save the macro in the current workbook file.

New Workbook: Create macros that you can run in any new workbooks
created during the current session.

Personal Macro Workbook: Choose this option if you want the macro
to be available whenever you use spreadsheet.

e. Description text box is used for writing a description of the macro. This
field is optional.

f. Click OK in order to create a macro.

g. Perform the actions you want to record.

h. Choose Stop Recording in the Code group of the Developer tab.

Let’s create a macro which converts a decimal number to a percentage (see
figure 10.32):
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b. Enter a name, for example, percentage

c. Select “This Workbook” from the drop-down list

d. Click Ok

e. Right mouse click on the active cell. Then click Format Cells

f. Select Percentage

g. Click Ok

h. Click Stop Recording

Fig. 10.32: Macro to convert decimal numbers to percentage

Now the macro named “percentage” is created. Save the file as Macro-enabled
Workbook.

Now we will run this macro to change a number format to percentage.

a. Select the cells contacting data of “percentage out of total budget”.

b. On the Developer tab, click Macros.

c. Select “percentage” macro and then click Run.
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Fig. 10.33: Converting decimal numbers to percentages

The code of percentage macro can be viewed by first clicking Macro in code
menu and then clicking the edit button. The information can be seen when the
Visual Basic Editor window appears as shown in the figure 10.34.

Fig. 10.34: Visual Basic Editor Window

We can also write the code for creating macros but it requires programming
knowledge. So, we can create macros to automate your routine tasks in
spreadsheet without going in deep of programming.

10.3  OPENSOURCE SOFTWARE

In this lesson we have used excel 2007 for understanding the working of
spreadsheet. We can also use the Calc application in OpenOffice which is a free
and open productivity software from Apache (https://www.openoffice.org/).
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WHAT YOU HAVE LEARNT

In this lesson, you have learned the following:

DifferentAafreen sheets present in a spreadsheet are First sheet, Previous
sheet, Next Sheet, and Last Sheet.

Two ways of cell referencing techniques are Relative and Absolute.

All cell references are relative references by default.

Some of the commonly used functions are SUM, AVERAGE, COUNT,
MAX, MIN.

Freeze Panes allows user to view and enter the data in distant parts of the
worksheet.

Filtering of data is used when we want to display some specific part of data
instead of the entire data.

Sorting of data is used for reordering data in a spreadsheet.

Different Conditional formatting options are Highlight Cell Rules, Top/
Bottom Rules, Data Bars, Colour Scales, etc.

Data validation checks are required to ensure that only correct data is
entered in a cell.

Pivot Tables are used to summarize, analyse, explore and present your data
in a spreadsheet by using few clicks.

Charts are used for displaying data graphically for the analysis purpose.

Visual analysis of data can be done by using charts.

Macros are pieces of programming code used for automating routing tasks.

TERMINAL QUESTIONS

1. What are the different data formats available in Spreadsheet?

2. Mention some frequently used functions in Spreadsheet.

3. What is the benefit of using formula in Spreadsheet?

4. What are the different cell referencing techniques used in calculation?

5. What is benefit of using Freeze Panes in Spreadsheet?
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7. What are the different techniques for analysing data without using charts?

8. Mention different types of charts used for data presentation.

ANSWERS TO INTEXT QUESTIONS

10.1

1. Iqbal should have clicked Start ’! All Programs ’! Microsoft Office ’!
Microsoft Office Excel 2007.

2. Satbir should have used referencing B$10 instead of $B10

3. Juhi should have used formula =SUM(C2:C10) in C11 cell.

10.2

1. Ishan should have applied filtering on the subject cell column and then
selected the specific subject from it.

2. Saahil should have used Highlight Cell Rules technique for it.

3. Aafreen should have used pie chart for displaying the percentage of different
items.
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11

PRESENTATIONS

Dear learners, you have learnt the basics of spreadsheet in the previous lesson.
In your daily life, as a student/employee/employer, you have to present your
work in front of others. You can present your work either verbally or in written
format. The visual medium of communication is a good way to present your
work to others. It aids in good understanding between the presenter and the
audience. In this lesson, you will learn about  PowerPoint a tool for presentation,
which will help you to make a good presentation of your work in a concise
and in a simple way.

OBJECTIVES

After studying this lesson, you will be able to

design a presentation using a slide template, themes, graphics, audio, video;

create a presentation with custom animation, transitions;

create and modify a master slide layout, and

print and present the slides in different ways.

11.1 PRESENTATION

PowerPoint includes features needed for making a good presentation. It consists
of a series of slides. A slide in a presentation displays the information you want
to communicate to your audience. This information can include text, graphics,
charts, video, sound, etc.

1. Creating a Presentation

In this section, we will be learning how to create a presentation. For creating
presentation using PowerPoint you need to go to:
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All Programs →

Microsoft Office →

Microsoft Office PowerPoint 2007

The opened presentation is shown in figure 11.1:

Fig. 11.1: Opened Powerpoint

When a new PowerPoint presentation is created, only one slide appears by
default. Click Create button and a new presentation will open in the PowerPoint
window. The default slide that appears in presentation is a Title Slide layout.

2. Slide Basics

Slides contain placeholders (areas) on a slide that are enclosed by dotted borders.
Placeholders can contain many different items, including text, pictures, and
charts. Thumbnail-sized icons represent specific commands such as Insert
Picture, Insert Chart, and Insert Clip Art, etc. You can get the details of each
icon by taking your cursor over different icons.

The placeholders are arranged in different ways in the layout that is selected
when a new slide is inserted or applied to existing slides. The layout in figure
11.2 is called Title and Content that includes title and content placeholders. Click
inside the placeholder for inserting text. The placeholder text will disappear and
the insertion point will appear. Start typing your text when the insertion point
is visible. Once you have entered all the text, click outside the placeholder.
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Fig. 11.2: Different areas on a Slide

3. Layout

A slide layout arranges the slide contents. Layouts contain different types of
placeholders depending on what information has to be included in the presentation.
Each layout has a name and the image of the layout shows you how the
placeholders are arranged on the slide.

The layout of an existing slide can be changed by clicking the Layout command
in the Slides group on the Home tab. A menu appears with different options.
Choose an option to select it. The layout of the presentation will change in the
presentation (see figure 11.3).

Fig. 11.3: Slide Layout
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a. A new slide can be inserted by clicking New Slide icon on the Home tab.
A menu will appear with your slide layout options (see figure 11.4).

Fig. 11.4: Inserting a new Slide

b. Click the slide you want to insert. A new slide with the chosen layout will
appear in the center of th e PowerPoint window and in the pane on the left.

5. Copy, Paste, Delete, Move Slide

The copy and paste of a slide can be done by using icons on Home tab as shown
in figure 11.5. Alternatively, the keyboard shortcuts Ctrl+C and Ctrl+V
respectively can be used for it. You have to select the slides you want to copy
and move the insertion point to the location where you want the copy of the
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The slides can also be deleted by using the delete icon on Home tab.

Fig. 11.5: Copy, Paste, Cut icons in presentation tool

A slide can be moved from one location to another by first selecting the slide
in the left task pane and then clicking and dragging the slide to a new location.
The insertion point will appear.

6. Different views from the PowerPoint window

PowerPoint gives you the ability to view the presentation in different ways. For
example, if you want to present your work to an audience you can use the “Slide
Show” view. PowerPoint window has four view options. The view can be
changed by clicking the following (see figure 11.6):

Fig. 11.6: Different views of a PowerPoint

(i) Normal: It is the default view. Creating and editing of slides is done in
the center slide pane. All of the slides will appear on the Slides tab in the
left task pane.
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presented horizontally and more slides can be seen at the same time.

(iii) Slide Show: The entire presentation slide will appear on complete screen.

(iv) Notes Page view. It provides space for notes. It is also known as speaker
notes view. The notes can be added to the presentation from this view.

First three views are also available in the bottom-right corner as shown in figure
11.7.

Fig. 11.7: Views available at the bottom right corner

11.2 THEME

A theme is a predefined combination of colours, fonts and effects that can be
applied to your presentation.  PowerPoint includes built-in themes that can be
used for creating presentations in order to save time in formatting (see figure
11.8). Each theme has additional background styles associated with it that can
be applied to the slides to modify the theme. A theme is automatically applied
when a new presentation is created.

A theme can be applied by locating Themes on the Design tab. Each image
represents a theme. More themes can be selected by clicking the drop-down
arrow. You can click a theme that you want to apply in your slides.

Fig. 11.8: Different Theme Options

The current theme colours, fonts, and effects can be modified to create a new
custom theme. A different theme font option can be applied by clicking the Fonts
icon in the Themes group on the Design tab. In order to switch to a different
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select an effect option from the menu that appears.

Background styles can be added to your slides after a theme is applied. The
background styles are updated when you switch to a different theme. The colours
are different based on the theme colours. A background style can be selected
by clicking the Background Styles icon in the Background group on the Design
tab.

11.3 TEMPLATE

A PowerPoint template is a blueprint of a slide or group of slides that is saved
as a .potx file in your computer. Templates can contain layouts, theme colours,
theme fonts, theme effects, background styles, etc. A custom template can be
created and saved so it can be reused later as in figure 11.9.

Fig. 11.9: Saving a Custom Template

INTEXT QUESTIONS 11.1

Find out what went wrong. Write the correct steps to do the following.

(i) K. Mostak wanted to start a new presentation. He clicked Start →

Microsoft Office →  All Programs →  Microsoft Office PowerPoint 2007
→  File.



 65

Presentations MODULE - III

Notes

Employability Skills

Going DigitalAns. K. Mostak should have clicked ______________________________

____________________________________________________________

(ii) Abhilash wants to save colours, font, effects used in his present presentation
for further use, so he saved the file as .pptx

Ans. Abhilash should have _______________________________________

____________________________________________________________

(iii)  Jasmine wants to present her presentation slide by slide, she has chosen
normal view, she should have chosen

Ans. Jasmine should have chosen__________________________________

____________________________________________________________

11.4 INSERT GRAPHICS, AUDIO, VIDEO, CHART,
CREATING HYPERLINKS

1.  Insert Graphics

Graphics can be inserted by using the Insert tab or by using icons in the
placeholders as in figure 11.10. After selecting the Insert tab, click the Insert
Picture icon in the Illustrations. Locate and select the picture in the Insert Picture
dialog box that appears. Finally, click Insert so that graphics appears on the slide.
The resizing and moving of graphics can also done by using the appropriate
steps.

Fig. 11.10: Inserting graphics from a location
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placeholder. Locate and select the picture in the Insert Picture dialog box that
appears. Click Insert so that graphics appear on the slide.

2. Inserting Audio, Video

An audio or movie clip can be inserted from a file on your computer or from
the Microsoft Office clip organizer. You can also manage how the movie will
operate in the presentation.

Fig. 11.11: Inserting video in a presentation

Different steps to insert audio or video are as follows:

a. Select the slide where you want to insert the movie/audio.

b. Select the Insert tab. Click the drop-down arrow on the Movie/audio icon
in the Media Clips (see figure 11.11).

c. Select Insert a Movie/audio from File from the menu. The Insert Movie
dialog box will appear.  Locate the file you want to insert from your
computer. Click the file name.

d. Click Ok.

e. The movie/audio will appear on the slide. Click Automatically or When
Clicked. Automatically will start the movie automatically as soon as the slide
appears in Slide Show view, while When Clicked will start the movie when
you click.

3. Inserting Chart

Charts help the audience to understand and compare the data in different ways.
A chart can be inserted in the slide as follows:

a. Click the Insert Chart command. The Insert Chart dialog box appears.

b. Click and drag the scroll bar to view the chart types, or click a label on
the left of the dialog box to see a specific chart style as shown in figure
11.12.

c. Click a chart to select it.

d. Click Ok. Excel will open. Usually, Excel will appear on one side of the
screen, while PowerPoint appears on the other side of the screen.
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you’ll replace with your own information. The Excel source data is used
to create the PowerPoint chart.

Fig. 11.12: Inserting chart in a presentation

4.  Creating Hyperlinks

A hyperlink is a link or reference from a slide to a webpage, slide, file, etc.
A person can directly follow to a particular location by clicking it. A hyperlink
can be created as follows:

a. Select the Insert tab.

b. Select the text or object you want to use as a hyperlink.

c. Select the Insert tab. Click the Hyperlink command in the Links group. The
Insert Hyperlink dialog box will appear.

d. If you use text for the hyperlink, the Text to display field will appear active
in the dialog box. The text you select on the slide will appear in this field.
In this example, text is selected as “NIOS”.

e. Click Existing File or Web Page.

f. In the Address field, enter the website address you want to display when
the link is clicked. In this example address is http://www.nios.ac.in/ (see
figure 11.13).
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Fig. 11.13: Inserting Hyperlink

Activity 11.1

After analysing his current situation, Topo has decided that he wants to open
a small business as part time beyond his job hours. He approaches a small bank
for a loan to start his business. Bank manager has told him to fill the loan
application and give a presentation about what he proposes to do. Help Topo
to prepare a presentation including the following things:

1. About him

2. Inserting his picture

3. His education including hyperlinks to the schools or university sites.

4. Job expertise including hyperlinks to the company website, if it exists.

5. Total expenditures

6. Net savings

7. Total salary drawn

8. Proposed business plan

9. Proposed loan amount

11.5 APPLYING CUSTOM ANIMATIONS, TRANSITIONS

1. Applying Animation

Animation on a slide is used to draw the attention of audience to specific content
or to make the slide easier to read. An animation can be implemented as follows:

a. Select the text or object on the slide you want to animate.
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task pane will appear on the right.

c. Click Add Effect in the task pane to add an animation effect to the selected
text or object.

d. Select Entrance, Emphasis, Exit, or Motion Path to display a submenu
of animation effects for the category.

(i) Entrance: Changes how the selected item appears on the page

(ii) Emphasis: Draws attention to the selected item while the slide is
displayed

(iii) Exit: Changes the way the selected item disappears from the slide

(iv) Motion Path: Animates the selected item so it moves to a specific place
on the screen

e. Select an animation effect to apply it.

f. The animation will display on the selected item on the slide and will appear
listed in the Custom Animation task pane.

(i) A number label appears on the slide next to the animated object. A
matching number label also appears next to the animation in the Custom
Animation task pane list.

(ii) Drop-down menus appear at the top of the Custom Animation task
pane. You can define the animation effect in greater detail here.

(iii)  Play Animations icon appears beneath the slide on the Slides tab in
the task pane on the left. It indicates that the slide has an animation
effect.

An example of created animation is shown in figure 11.14.

Fig. 11.14: Including a Custom Animation
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Transitions are movements when one slide changes to another in Slide Show
view. A transition refers to the movement of the slide as it changes to another
slide while animation refers to the movements of text and objects on the slide.
The transition to one slide can be applied as follows:

a. Select the slide you want to modify.

b. Select the Animations tab as shown in figure 11.15.

c. Locate the “Transition to This Slide”. By default, No Transition is applied
to each slide.

d. Click the More drop-down arrow to display all available transition effects.

e. Click a slide transition effect to apply it to the selected slide.

Fig. 11.15: Applying a transition in a slide

The transition to all slides in the presentation can be applied by clicking “Apply
To All”.

11.6 CREATE AND MODIFY MASTER SLIDE LAYOUT

The slide master allows you to make changes to all slides or a specific slide
layout. It saves time when you are making the same changes to all slides in your
presentation. It stores information on the theme, including font style, colours,
effects, placeholder size, text alignment, etc.

a. Select the View tab.

b. Click the Slide Master view icon on the Presentation Views as shown in
figure 11.16.

Fig. 11.16: Location of Slide Master
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slide master task pane will appear on the left.

d. The Slide Master view appears similar to Normal view; however, in Slide
Master view, master slides are displayed in the task pane rather than actual
slides. The first thumbnail image in the task pane on the left is the slide master
that controls all slides.

Fig. 11.17: Opened Slide Master

To change text colour/alignment on all slides, the following steps can be
followed:

a. Select the slide master for all slides, if it is not currently selected.

b. Select the text you want to modify, and format it how you want.

c. Select the Home tab. The slide master and supporting layouts will remain
in the slide task pane on the left because Slide Master view is the current
view.

d. Click the Font Colour icon in the Font.

e. Select a font colour from the menu options. The font colour change will
appear on all the slides in the task pane on the left.

f. Click an alignment command to change the alignment of the selected text
as shown in figure 11.18.
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Fig. 11.18: Changing Text Alignment in Master Slide

Similarly, a picture can be inserted in all slides.

Activity 11.2

After creating the presentation in Activity 11.1. Topo want to improve his
presentation.

Help Topo to improve his presentation by doing the following things:

1. Include animations in slides

2. Include the spreadsheet charts prepared in the previous activities.

11.7 PRINTING SLIDES IN DIFFERENT WAYS

Printing of the slides can be done in different ways depending on your needs
(see figure 11.19). Different ways of printing are as follows:

1. Slides: It is used when you want to print one slide per page of a presentation.

2. Handouts: It is used when you want to print several slides per page. The
default is six, but you can change it to four or set another amount of slides
per page.

3. Notes Pages: It is used when you want to print speaker notes for the slides.

4. Outline: It is used to print all the text of the slides in a presentation.
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Fig. 11.19: Different printing option of a presentation

Activity 11.3

After improving his presentation in Activity 11.2, help Topo to take the print
out in as notes pages and handout formats.

Topo was very happy when his loan was approved by the bank after his good
presentation indicating his strengths in a good manner.

INTEXT QUESTIONS 11.2

Find out what went wrong in the following. Write the correct steps.

(i) Ramesh has done the same alignment of text in his all slides, he do not want
to repeat the alignment again and again, he should have done

Ans. Ramesh should have done___________________________________

____________________________________________________________

(ii) Juhi wants to display the entire contents of NIOS website in a slide, so she
has taken print screen (PrtScr) of the website contents, she should have

Ans. Juhi should have _________________________________________

____________________________________________________________
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taken one slide per page print out, he should have

Ans. Sopu should have  ________________________________________

____________________________________________________________

WHAT YOU HAVE LEARNT

Placeholders Slides contain placeholders on a slide that contain
different items, including text, pictures, and charts.

Slide Layout A slide layout arranges the slide contents.

Views Different views of PowerPoint are Normal, Slide
Sorter, Slide Show, Notes Page view.

Theme A theme is a predefined combination of colours,
fonts, and effects that can be applied to a presentation.

Template A template is a blueprint of a slide or group of slides
that contain layouts, theme colours, theme fonts,
theme effects, background styles, etc.

Hyperlink A hyperlink is a reference from a slide to a webpage,
slide, file, etc.

Slide Master The slide master allows you to make changes to all
slides or a specific slide layout.

Format of Printing Different formats of printing a presentation are
slides, handouts, notes pages and outline.

TERMINAL QUESTIONS

1. What are the benefits of using a presentation?

2. What is a Master Slide?

3. What are the benefits of making a Master in the beginning?

4. Mention the process by which you can insert a video in your presentation.

5. What are the different effects of animation?

6. What are the different ways of printing presentation slides?
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ANSWERS TO INTEXT QUESTIONS

11.1

(i) K. Mostak should have clicked

Microsoft Office →  All Programs →  Microsoft Office PowerPoint 2007
→  File.

(ii) Abhilash should have saved the template as .potx.

(iii)  Jasmine should have chosen slide show for her presentation.

11.2

(i) Ramesh should have done this alignment in the master slide of the
presentation.

(ii) Juhi should have given hyperlink of NIOS website on a slide instead of
pasting the contents by using print screen.

(iii)  Sopu should have taken handouts of the presentation.
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12

YOU IN THE WORLD OF WEB

Ashok has been running a tailor shop in the bye-lanes of Karol Bagh for the
last thirty years but today…
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Fig. 12.1: Changing the way of business

OBJECTIVES

With Tarunima’s help, you and his father will be able to:

surf the internet and use basic internet tools using web browser and search
engines;

create and sign in  to an email account;

discuss important terms like URL,IP Address, ISP, bandwidth;

describe the role of emails for sending mailers to improve business, and

explain cloud computing and its practical application.
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“Power of internet? What is this internet???” asks her father.

“Papa, the internet is a large network of connected computers. It is so big that
many computers throughout the world are connected to it and that is why we
call it “World Wide Web” or WWW or even internetin short.

According to the Merriam-Webster dictionary:

“But I have heard that this internet is a very bad thing. Just yesterday, our
neighbor Sharmaji told me how his son has got so addicted to it that he is not
concentrating on his studies. He is not even helping his father in their sweet
shop.” said Tarunima’s father with a deep concern.

“Well Papa, the internet is an open medium available to everyone. It has both
positive and negative aspects but I strongly feel that we should have the ability
and the conscience to use it positively.

If we use it positively, we can really do wonders in our life by imbibing the infinite
knowledge that internet has to offer. For example, the computers are connected
to the internet and store millions of pages of information on almost anything
you can think of. It has thousands of pages of suit designs which we can view
and use for creating our own special suits. In the world of web, these pages
are called as websites and we need a tool in our computer to open these
websites. This tool is known as a web browser.

a set of related web pages 
located under a single 
domain name.

A web browser (commonly 
referred to as a browser) is 
a software application for 
retrieving, presenting and 
traversing information 
resources on the World 
WideWeb.

W
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Fig. 12.2: Understanding website and web browser

On the negative side, there are cyber-crimes like cyber bullying and cyber
stalking where people bully or threaten other people without any reason. Again,

Internet
noun | In·ter·net | \ in-tr-net

an electronic communications network
that connects computer networks and
organizational computer facilities
around the world
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as, “the use of electronic communication
to harass or threaten someone with
physical harm”. There is account
hacking where people hack these
websites and put profane messages there. Hackers also release ransomwares
which lock the recipient’s computer and these hackers then demand money to
unlock them. We should be aware of these negative aspects. I will tell you more
later about this but for now let’s continue from where we left.”

“Yes, you well telling me about web browsers”, replied father.

Fig. 12.3: Different web browsers

There are many web browsers available on the internet. Some of the popular
ones are: Google Chrome, Mozilla Firefox, Internet Explorer, Apple Safari and
Opera. Other than Internet Explorer, all the rest are freewares or softwares
which are available free of cost.

Here is what a Google Chrome browser looks like:

Fig. 12.4: Google chrome browser

hacker:
a person who uses com-
puters to gain unauthorized
access to data.
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This is where we write what we want to search and we press the ‘enter’ key
of our computer. Now I will search ‘suit embroidery designs’ and see!”

Fig. 12.5: Google Image search

“Wow. This is amazing!! But how are these designs coming on your laptop?”
asked her father.

“Every browser has a search engine integrated into it which helps us find the
desired information from web. These search engines pick up our keywords and
find the relevant pages or websites having the same keywords in them. Various
search engines used for this purpose are Google, Bing, Yahoo, AOL, etc.”

Activity 12.1

Explore internet and find out the names of various search engines available on
internet? List top three search engines below:

1. ……………………………………………………………………………

2. ……………………………………………………………………………

3. ……………………………………………………………………………

Also mention how many search queries do they receive every second.
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Fig. 12.6: Websites address

“Not necessary papa. These pages or websites can be opened by writing their
address in the address bar of the browser. This address is called URL or
Uniform Resource Locator. It starts with the letters ‘WWW’ which is the short
form of World Wide Web. After WWW there is the actual name of the website
followed by a domain name which is normally signified as ‘.com’ for commercial
sites, ‘.org’ for non-profit organisations, and ‘.in’ for Indian sites.”

“Wow, tell me more!” exclaimed her father with joy while looking through the
pages showing hundreds of embroidered suit designs, patterns, colour schemes,
apparel textures, etc.

Did you know??
There are more than 255 domains registered in the names of countries like .in
(India), .uae (United Arab Emirates), and .jp (Japan)
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Tarunima continued further, “As a next step, we can also keep in touch with
our existing customers using another tool called e-mail. An email is an electronic
form of sending letter to a recipient with a few clicks only which reaches within
few seconds.”

“But how does it find the address of the recipient so quickly?” asked herfather.

“Good question, papa!” laughed Tarunima, “It doesn’t need the physical address.
What it needs is an email address to reach the recipient. Every person using
an email has to create an email address. This is a unique address and no two
people can have the same email address. This is called as an email ID. The email
ID typically has two parts – the username and the domain/host name. The
user name and the domain name are both connected with each other with an
‘@’ (at) sign. Here let me write down my email ID to explain you the format
for your easy understanding.” said Tarunima.

tarunimakumar gmail.com

Fig. 12.7: Component of an email ID

Now if you notice, my username at gmail is tarunimakumar which is connected
to the second part of my email ID called the domain name. The domain name
is the name of a particular area within the internet over which an organization
has control. This area is registered in the name of that organization by a body
called as a Domain Naming Registrar and once registered, the organization can
do many things like hosting a website or creating email IDs for all its people.

So if I have my email ID created at gmail domain and if you send me any email
at this ID, I will receive it immediately” said Tarunima’s father.

“No papa first you will have to connect my laptop to the internet and only then
would you be able to open your email. To connect to internet, I will connect
my smart phone to the internet and turn on the hotspot. Then I will connect
our laptop to the hotspot and we will be connected to the world of web!”
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Fig. 12.8: Sending an email

“Hotspot?”

Well, you connect a computer or laptop to the internet using a smartphone these
days. There is a function called hotspot which when switched on, other laptops
or computers can connect to it and get connected to the internet.

“Oh! So we need to connect to the internet…but who gives us this internet?”
father again asked.

“Yes papa, we need to connect to the internet using our account which is given
to us by our ISP or Internet Service Provider. The ISP is the organization
which maintains our internet account and gives us a usage plan which is limited
to a certain bandwidth and data usage.”

“Bandwidth?”

“Yes, Bandwidth. Each time we open a website or send/receive an email on the
internet, a certain amount of data is exchanged. In simple words, the speed with
which this data is exchanged is called as the bandwidth whereas the amount
of data exchanged is called data usage. Bandwidth is measured in bits per
second while data is measured in bytes. You know how many grams make a
kilogram? Tarunima asked trying to test her father’s general knowledge.

“Yes, yes. Why wouldn’t I know? We get so many things in our raw material
in kilograms. It’s one thousand grams. One Thousand Grams make one
kilogram.” Exactly, but do you know in the world of web, it’s not one thousand
but One Thousand and Twenty Four bits per second that make One Kilobit per
second or 1 kbps of bandwidth in short. Similarly, One Thousand Twenty Four
bytes of data make One Kilobyte or 1 Kb of data.
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Fig. 12.9: Everyone can have an email ID

“Relax papa, we can still get an email ID even if we are an individual. There
are many free email providers in the world of web like Google, Hotmail,
Yahoomail, Indiatimes, Rediffmail, etc. which offer free email services. Let’s
make your email ID at one of these service providers. We will create our ID
at one of the popular email ID providers called ‘Gmail’. Here are the steps:

1. Open the email ID creation page on gmail website. The URL or website
address for this is https://accounts.google.com/SignUp

2. Fill up the form as shown below.”

Fig. 12.10: Steps of creating an email ID

Did you know??
Bandwidth Data
1024 bits per second = 1kbps 1024 bytes = 1Kb
1024 kbps = 1mbps 1024 kb = 1mb
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passwords are the ones which are created using the guidelines given in purple
box in figure 12.10. If we don’t create strong passwords for our email
accounts, hackers can easily break them and gain access to all our mails and
related data.

URL or Uniform Resource Locator is the address of a World Wide Web
page that you type in the address bar of the browser.

Activity 12.2

1. Create a decent email ID for your friend’s profession and write it down
here: ...............................................

2. Create your email ID on Gmail.com, yahoo.com, and rediffmail.com and
note down the difference in the fields you filled in while creating these email
IDs.

3. Write an email to your friend/tutor sharing your aspiration that you wrote
for lesson 3.

Now we have created our email ID called bharattailors1@gmail.com. We can
now use this email to send mailers to our existing clients on the latest designs
that we are creating by attaching the pictures of these designs in the mailer.

“You mean we can attach pictures like the ones we saw in the website on suit
embroidery designs that you opened just now?” asked her father.

“Not only pictures but we can also attach articles, files, or even videos in an
email message. On our smartphone, we can record a video of how you make
some of the finest hand woven embroidery on a suit and we can send it to all
our clients so that they can see the workmanship and hardwork behind each
suit unlike the machine embroidered ones available at other sites.”

“So how do we attach such a video or pictures, Tarunima?” father was keen
to know more.

“Very simple. Just open the newly created email ID by writing the URL
www.gmail.com in the browser address field and upon hitting the enter key on
the laptop, you will see the login screen. Fill in the required details of username
and password and press the ‘Submit’ button and you will enter the inbox of your
email. On the left side frame, click on the ‘Compose’ button and a new email
form like the one shown below will open.”
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Fig. 12.11: Composing and sending an email

Activity 12.3

Assuming you are Tarunima and one of your friend needs your help in learning
to open his email and create a message. Write all the steps required to do so
and also. inform him about the dangers of cyber stalking and advise him about
the responsible useof email.

……………………………………………………………..........………………

……………………………………………………………..........………………

……………………………………………………………..........………………

……………………………………………………………..........………………

INTEXT QUESTIONS 12.1

1. Differential between:

a) www.nios.ac.in and abc@nios.ac.in

b) 1mbps and 1mb

c) Username and domain name
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a) All browsers perform different function.

b) An email has user name and host name separated by dot.

c) www.google.com and www.nios.ac.inare search engines.

d) URL called as the address of the website.

3. Choose the correct answer:

a) A software application used to display web pages is called

A. Search Engine

B. Home Page

C. Web Browser

D. Web Site

b) A Domain name ending with .com belongs to

A. An educational institution

B. A commercial website

C. An organization

D. A site that is highly organized.

c) Full form of ISP is

A. Information Search Protocol

B. Internet Service Process

C. Information Service Provider

D. Internet Service Provider

4. What would happen if you:

A. click the send button without writing the email address?

B. Forget to attach a file and click the send button ?

C. Send a mail without writing the subject?

5. Internet is both a positive as well as a negative medium. Can you give three
examples of each of its positive and negative facets?



MODULE - III You in the World of Web

 88

Notes

Employability Skills

Going Digital 12.3 CLOUD COMPUTING

Fig. 12.12: Cloud computing
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factories with lakhs of computers kept in endless racks. These computers are
shared with us over the internet and our email and websites run on these
computers. Since they keep our data in the virtual world, saving us from the
need to store it locally on our hard drive, we refer to this concept of computing
as cloud computing. For example, all the emails and attachments coming in or
going out from our gmail account bharattailors1@gmail.com will be kept at
the google cloud and not on our laptop. These computers never stop working,
they are always available any time, and from any place.”

Fig. 12.13: Benefint of cloud computing

12.4 ADDITIONAL APPLICATIONS OF CLOUD
COMPUTING

“So other than email and websites, what all does the cloud has to offer?” asked
father.

“You initially talked about accurate record keeping remember?”

“Yes, yes…that is my biggest pain area. I always tend to forget how many
customers had purchased suits or got their ones stitched from me on credit.”

Did you know??
The cloud also offers us tools like documents, spreadsheets, presentations, and
online forms to automate our day to day transactions.
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spreadsheet which were available
on your local computer/laptop.
In cloud computing you would
find these spreadsheets available
online. For example, such
documents offered by ‘Google’as
google drive service. This service is a free Web-based application in which
documents, spreadsheets, drawingsand presentation can be created, edited and
stored online. Files can be accessed from any computer with an Internet
connection and a full-featured Web browser.

Small businesses can start using cloud storage services for free.”

“Free!!! That’s really great. A small tailoring business like mine cannot afford
to buy expensive software.” father was really happy now.

“Now that we already have a Gmail account, we can use the same to login to
Google Docs and begin to create, store and most importantly, share the
documents we have created. Further papa, we no longer need to worry about
its data storage and back-up since this will be completely handled by the cloud
service provider. Also, do you know that from now onwards your business will
walk with you where ever you go? asked Tarunima.

“Walk with me? How can my tailoring business walk with me?” father was keen
to know.

“Cloud computing also offers you an online hard drive
which is your personal storage space to save your documents,
audio, video, etc. online. For example, Google Drive is one
such drive which can be accessed with your gmail account
from anywhere, anytime. Google Drive is also available on
most of the android smartphones as a mobile app.Whenever you are visiting a
valuable customer for that special suit, you can simply record all the measurements
online in a spreadsheet without the fear of losing it on a piece of paper.

Similarly, you could create a separate sheet for each customer keeping a record
of all the payments and overdue collections in one place.

“Tarunima, all this is really really great but is there a way we can take care of
unhappy customers?”

“Father, I know you get very upset when clients give a negative feedback but
fail to let you know when they are happy. Feedback is extremely important for
any small business. It helps us improve our products or services thereby
improving the loyalty of our valuable customers towards us. We can use online
forms to actively seek feedback for every sale we make.

Fig. 12.15: Drive

(a) word (b) Spreadsheet (c) Presentation

Fig. 12.14
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Fig. 12.16: Online forms

Online Forms is a free online option for capturing data. After every sale, we can
send an online survey form to our valuable customers asking as many questions
as we can.

Collecting Responses

Fig. 12.17: Collecting Responses
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click of a button. Just click “Responses” at the top of the screen and you’ll see
how many responses you’ve got. If you want to get those responses in a
spreadsheet, click the green box with the cross on it. It will export to a Google
Sheet.

So now papa, are you ready to dive into the world of web and make waves
with your beautiful designer suits?”

“Tarunima, today I am so happy that I sent you to NIOS for the Employability
and Entrepreneurship Course inspite of our family and friends opposing my such
a move.” father had tears in his eyes while he hugged his beloved daughter to
thank her for the new world she had lead him to…the world of web!

WHAT YOU HAVE LEARNT

WWW

web sites

Client Browser
Search Engines

websites

ISP Internet Bandwidth

Domains Domains

Online Forms

Marking Mailers

E-Greetings

Product Catalogues

Business Announcement

.com

.in

.org

www.google.com

www.nios.ac.in
Feed back

Response
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TERMINAL QUESTIONS

1. Write a short note on internet in changing the face of business today?

2. What is the difference between internet and  website? Which authority
registers a website?

3. How is a website different from a search engine?

4. How is sending an email is different from posting a letter? Write five
differences.

5. Explain the difference between the Bit an Byte .

6. How can online docs help you to improve your business? Explain in 150
words.

7. You have been requested to help yourfriend to,keep a track of daily salesin
his grocery business using cloud computing Explain the process.

8. In what ways do online forms Help in maintaining quality standards of a
business?

9. As a budding entrepreneur explain five ways in which you will use internet
in making your business customer friendly.

ANSWERS TO INTEXT QUESTIONS

12.1

1. (i) www.nios.ac.in is a URL (Uniform Resource Locator). abc@nios.ac.in
is an email address.

(ii) 1 mbps is 1 mega bits per second which is the amount of data that can
be transmitted in a fixed amount of time.

1 mb is 1 mega byte which is the size of data.

(iii) User name – A username is a name that uniquely identifies someone on
a computer system. For example, a computer may be setup with multiple
accounts, with different usernames for each account. Many websites
allow users to choose a username so that they can customize their
settings or set up an online account.

Domain name - A domain name is a unique name that identifies a
website. For example, the domain name of the Value Consultant
Company is “valueconsultant.com”.
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used to access the website.

2. (i) False, all browsers perform the same function of retrieving, presenting
and traversing information on internet in the form of websites.

(ii) False, an email has a user name and a host name separated by an “@”
sign.

(iii) False, google is a search engine while nios.ac.in is the domain name of
NIOS.

(iv) True. A URL is the domain name of a website prefixed with the letters
WWW.

3. (i) C; (ii) B; (iii) D

4. A. Clicking the send button without putting the email address will pop up
an error message and the email would not be sent anywhere since
recipient address is missing.

B. If you forget to attach a file and click the send button, the email will
still be sent.

C. The email will be sent without a subject.

5. Positive Facets-

(i) Finding new designs

(ii) Finding best raw materials

(iii) Contacting customers

Negative Facets-

(i) Cyber stalking

(ii) Spreading rumours or hate messages

(iii) Obscene sites.
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13

E-BUSINESS

In the last lesson you saw how Tarunima, a young and enthusiastic learner of
NIOS helped her father understand the world of web. Together they explored
various tools and technologies available in it. This helped her father learn new
ways of conducting business.

OBJECTIVES

After studying this lesson, you will be able to

utilize the digital media platform to promote your social identity in digital
world;

equip yourself to maintain socially safe digital identity;

identify various ERP (Enterprise Resource Planning) packages that can
facilitate the strategizing and policymaking for the company;

create a relevant market for your products or services; and

identify various secured websites before making any online transactions.

Ashok Kumar was very happy today. It had been a month since his daughter,
Tarunima, had trained him on using internet tools like search engines and email
to serve his customers better. With some savings, he had already bought himself
a laptop equipped with licensed software to help him surge ahead in business.
He was now well versed with using search engines to look for new designs and
fashion trends around the world. Having mastered the art of creating eye-
catching mailers on his online emails, he began to send his new suit designs to
all his valuable customers every fortnight. In turn, he would get a lot of queries
from customers asking about the availability of designs and prices. This practice
gradually picked up so well that he was spending almost 2–3 hours each day
replying to his customers about the availability and price.
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more designs. Let me ask Tarunima once she is back from NIOS,” he thought.

Tarunima entered the shop with a thick file and some books as she was busy
preparing for her practical project at NIOS.

“Tarunima, I wanted to discuss something very important with you,” he said
with a voice of concern.

“What is it papa?” asked Tarunima.

“You see Tarunima, now that you have given my life a new meaning by training
me on the wonderful world of web and its related tools and we have both started
using it for promoting our business. The business is doing extremely well. I am
proud of you for bringing in such a positive change in our lives. But one thing
that I have noticed recently is that I am spending too much time on online record-
keeping or sending replies to my customers on design availability and prices.
Most of my customers have stopped calling me over the phone. They have
started using the email for all their queries. Hence I have to spend a couple of
hours daily responding to them. I was wondering if there is a way to channelize
these two hours to my core skill of creating new designs.”

“Ok, papa. We would have to adopt ‘e-business’ now. This will to help you find
time for your creative pursuits.”

13.1 USE OF DIGITAL WORLD TO PROMOTE BUSINESS

“E-business?”

“Well papa, technically speaking, e-business means carrying out business
transactions of marketing, sale, purchase, and distribution of products or
services on the internet. The computer or laptop is an important tool to conduct
e-business which can also be done using tablets or smartphones now,” replied
Tarunima.

“So where do we start?” asked father.

“Well, the first place to start from is getting ourselves registered with the e-
commerce portals like amazon.com, flipkart.com, snapdeal.com and others.”

“Now what is this e-commerce?” asked father impatiently.

“Ok. Electronic commerce or e-commerce is the process by which businesses
and consumers buy and sell goods and services through an electronic medium.
E-commerce means covering the entire lifecycle of sale and purchase of a
product or service right from receiving the order and receiving payments from
the customer to receiving feedback after the delivery of the product. E-ommerce
is a subset of the wider concept of e-Business.
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E-Business:
• Covers the entire business 
 lifecycle from marketing to 
 sale-purchase and finally 
 distribution of products/ services 
 using the electronic medium 
 of computers  and internet.

• Wider concept than E-commerce

E-Commerce: 
The sale and purchase of 
products/services over the 

electronic medium of 
computers and internet.

Fig. 13.1: Understanding E-commerce and E-business

E-commerce portals have a worldwide reach so the entire world becomes our
market. People go to these portals to buy products online since they want to
save their time of travelling to a real market, finding the right shop and then
negotiating with the shopkeeper for better prices. Everything from food and
clothes to entertainment and furniture can be purchased online. Once we build
our identity on these e-commerce portals, we can reach thousands of valued
customers who can place orders with us and that too with advance payments.”

“You mean the payment will also come through the computer?”

“Have you forgotten papa? We searched for your laptop from one of these online
marketplaces using our smartphone and once we found a model we could afford,
we paid for it online from your bank account?” remarked Tarunima.

“Yes, that was really wonderful! I still don’t understand how those people got
the payment just at the click of a button and sent me the laptop the very next
day through courier.” Father was still wondering while silently admiring his new
laptop.

“And after you opened your email on your new laptop, what did you find?”
Tarunima asked again.

“Yes I remember. There was this email from the seller requesting me to give
them a feedback on how was the laptop I had ordered; did I receive it on time
or not; would I recommend the seller to others or not?” replied father.

“So once you gave the feedback to the seller, you had actually completed the
transaction lifecycle of a typical e-commerce transaction which is shown in figure
13.2.” informed Tarunima.

“And you also said in e-commerce, the businesses buy and sell goods. Can you
explain that a little more?” Father wanted to know more.
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Fig. 13.2: Models of E-commerce

“I am glad you asked that question Papa. Now tell me if you had to source
the best Zari thread for some Zari work on one of your special silks, how would
you source it?” Tarunima asked smiling.

“Wait a minute, you mean we can do that through e-commerce?” Father was
now coming up with answers himself.

“Yes… off course! The way you searched for suit embroidery designs on one
of the search engines, let me open my Amazon.in account for you. Just type
in Zari thread?” instructed Tarunima.

Fig. 13.3: Home page of e-business site

“Oh my God! I can see hundreds of sellers online selling the Zari thread.”
exclaimed father.

“So you see, not only can you sell your products to the end customers or
consumers online but you can also purchase all the required raw material for
your products online from various raw material suppliers. These two different
modes where on one hand we are customers to raw material suppliers and on
the other hand are sellers to end customers are respectively called as B2B and
B2C channels of e-commerce.

In B2B or business to business channel, one seller sells raw materials,
machinery or services to buyers who use them for intermediate consumption,
that is, for producing goods or services for the end consumer.
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or consumer who consumes such goods or services.”

“So when I will be selling my suits directly to a customer through let’s say,
Amazon.in, I will be doing a B2C transaction and when I will buy raw materials
like this Zari thread from some company based out of Kanjivaram, I will be doing
a B2B transaction, right?”

“Right you are, Papa!” Tarunima replied joyfully.

INTEXT QUESTIONS 13.1

1. E-business and e-commerce are same. Comment.

2. List the tools/hardware required in e-business.

3. Name any three e-commerce portals that you would visit online for buying
a birthday gift for your friend.

4. State True or False giving reasons:

(i) E-business means conducting business in physical form.

(ii) Only very limited products can be purchased using e-commerce portals.

(iii) E-commerce portals reach very few customers.

5. Complete the lifecycle of an e-commerce transaction.

6. Your friend wants to buy air conditioner online. Help him by listing all the
steps to search for it.

7. Name the business model if you are buying groceries from internet.

8. Name the business model if you are selling wood to furniture houses.

“Okkk…So what next?” asked father.

“Both B2C and B2B channels of marketing are created by adopting digital
marketing instead of the conventional mode of marketing and to adopt digital
marketing, we need digital identity.”

“Digital marketing, digital identity… what is all digital here? The only digital
thing I know is my digital calculator which I use for measurement and rate
calculations.

“OK, so we will start with Digital Marketing. Now according to Financial
Times,

‘The marketing of products or services using digital channels to reach consumers
is called digital marketing. The key objective is to promote brands through
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marketing to include channels that do not require the use of the internet. It
includes mobile phones (both SMS and MMS), social media marketing, display
advertising, search engine marketing, and any other form of digital media.’

 Now… for digital marketing to be a reality, it is important for us to have a
digital identity. According to Digital ID and Authentication Council of Canada
(DIACC), ‘A digital identity is an electronic representation of who you claim
to be and who you are.’ So a digital identity is actually your identity in the digital
world,” replied Tarunima.

Fig. 13.4: Digital Identity

“You mean ‘Bharat Tailors’ can have a digital identity?” asked father.

“Yes, papa. Not only can ‘Bharat Tailors’ have digital or social identity, it can
also transact business with others using this identity. We just need to create our
own page on each of the digital marketing tools like linkedin, facebook, youtube,
twitter and others. Each of these tools started as social media tools with the
sole objective of bringing like-minded people together but have slowly evolved
into very powerful online or digital marketing tools. For example, once we have
created our ‘Bharat Tailors’ page on facebook, we can start uploading all our
designs there and this will bring all people searching for new suits to our
webpage. People can view our designs and give us likes or comments on these
designs. We can tag all these designs with a product code and a price so that
customers can get the prices from the facebook page itself instead of calling
us or writing to us. This entire set of activities is called as social media
integration.”

Activity 13.1

Create a facebook page for your business and share it with your friends. Upload
pictures of your products along with prices and description so that your friends
can view all information and give you likes/comments.

Also mention how many search queries do they receive every second.
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“Wow that’s great, so does it mean that ‘Bharat Tailors’ will be able to reach
thousands of customers through its digital identity?” asked father.

“Yes papa, but there is one thing you should be very careful about.” remarked
Tarunima.

“Careful about! What Tarunima?”

“Papa, remember I told you in the first session ‘You in the world of web’ that
just like the real world, this digital world is also full of cyber criminals like
hackers and cyber stalkers?”

“Yes, yes I clearly remember but why do you think we are at risk from these
hackers?”

“Once we create our digital identity for e-commerce, we would be having a lot
of information pertaining to our business going online on the internet. This could
be as follows:

Your personal information

All our customer records

All payment records for payments received online

Your creative designs which are actually your intellectual property

Besides these records, we would also face the risk from the following:

viruses and malware

spam (junk emails and adware)

cybercrime, such as being hacked

online scams

online payment and credit card fraud

13.4 ERP (ENTERPRISE RESOURCE PLANNING)

“Wow that will be amazing! But I still spend a lot of time in preparing manual
order lists and finally invoices. Is there any way we can automate these areas
as well?” father was now ready to dive deep in to the sea of digital marketing.

“For that, you will have to adopt ERP,” replied Tarunima.

“ERP? I have only heard of TRPs for which these various TV channels are
always competing with each other. What is this ERP?” asked father again.

“Oh Papa, ERP or Enterprise resource planning is business process management
software that allows an organization to automate all its business processes like
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Resource Planning softwares consist of various modules which can be integrated
with each other to build a complete process automation of entire business. Each
module handles a specific business process like finance or sales for example,
and can talk to other modules to complete the full cycle of business process.
Look at some of the modules of SAP, one of the leading ERPs, has to offer.”
Tarunima replied.

Fig. 13.5: End User Service Delivery

“Each module can talk to other modules? What do you mean?” asked father.

“What I mean is Papa, that suppose a customer places an order for us through
one of these e-commerce portals like Amazon.in, we can connect that order
output to one of the ERP’s so that each time an order is placed, the ERP
automatically creates a Purchase Order against it. This PO would contain the
details of the suit required by the customer and the inventory module ERP would
be able to tell us if we have this particular suit in our stock or not. In case we
don’t have it, the ERP would send us a notification telling us that it’s not in
stock and so we should stitch one immediately.”

All the ERPs come in various sizes and the customer has the choice to select
one or more than one modules as per the size and requirements of their business.
Some of the very popular ERPs available in the market today are as follows:
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Microsoft Dynamics NAV

JD Edwards EnterpriseOne

Oracle E-Business Suite.

13.5 CREATING AN ONLINE MARKET

“So Tarunima, how do we start to create our own online business from here?”
asked father.

“Well papa, let me put all the steps for your easy understanding, one by one:

1. Get a domain name registered

2. Get a GST number

3. Create your social identity on social media sites namely facebook.com,
twitter.com and others

4. Register yourself as a seller with e-commerce portals, for example, Amazon.in,
flipkart.com and others

5. Start promoting your products and services using your social identity on
social media

6. Integrate your e-commerce site with a payment gateway to enable online
payments

7. Use online document management system like Google docs to manage your
sales and invoicing

8. Once your online business reaches a higher level, adopt ERP integration to
automate the order processing, invoicing and payment collection processes
of your business.

9. Going further from there, we can also build our own app which can be
downloaded by our customers from the play store. This app can give them
real time notifications of all the latest happenings at ‘Bharat Tailors’ besides
the usual business of transactions using their mobile phones.”

“That sounds great! So let us start working together on making ‘Bharat Tailors’
online with social identity.”

INTEXT QUESTIONS 13.2

1. Why it is important for you to create your digital identity for selling goods
online.

2. What all business processes can be handled through ERP?

3. List some of ERPs.

4. List all the steps to create an online business of electronic goods.
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ONLINE TRANSACTIONS

“Sure papa, but before you go ahead and put your personal information online,
you must ensure that the site on which you are putting your information is a
secure website or a website which will not misuse your personal information
for their own use,” replied Tarunima.

“What exactly do we mean by ‘secure website’?” asked father.

“Papa, each time we open a website, some information is sent from your
computer to the web server and from the web server to our computer. This
information is normally sent in ‘plain text’, which means anyone would be able
to read it if they see it. This information passes through many computers called
‘nodes’ while it is on its way to reach the one that’s hosting the desired website.

Similarly, if we were to put our credit card information online to purchase
something, this highly sensitive information can also be hacked and misused by
cyber criminals,” said Tarunima.

“Yes, yes I know. Just yesterday I was reading in the newspaper how an innocent
lady was robbed of sixty thousand rupees on her credit card after she put her
credit card details on some fake online shopping site,” exclaimed father.

“Exactly, papa. So to avoid this problem, we should ensure that we share
sensitive financial data only on websites that encrypt the data in such a way that
even if it is hacked, no one will be able to use it for their benefit,” replied
Tarunima.

“But how would we know if a website has encrypted our data for safety?” asked
father.

“Very simple papa. Websites use a protocol called SSL or Secured Socket Layer
which jumbles up the data into unreadable characters using a mathematical
formula. This process is called encryption. Once this data is received by the host
computer, it is unjumbled using the same formula which was used earlier. This
is called as decryption. All SSL-enabled websites encrypt the transmitted data
before transmission and later decrypt it to accept it into its relevant fields.”

“So how can we know if the site we are visiting is a secured site?” asked father.

“For that you just need to look at two things:

1. Check the web page URL, if it begins with the letters ‘https’ it’s a secure
connection.



 105

E-business MODULE - III

Notes

Employability Skills

Going Digital2. Check for the lock icon. The lock icon is displayed at different places in
different web browsers. For example, on Microsoft Internet Explorer, it is
displayed on the lower right portion as shown in figure 13.6.

Fig. 13.6: Look icon on Internet Explorer

In Mozilla’s FireFox, the lock icon is displayed in the lower-left corner as shown
in figure 13.7.

Fig. 13.7: Look icon on Mozilla’s Fire Fox

So once you are sure that it’s a secure site, you can also make online payments
like we did for your laptop earlier, without being scared that these would be
siphoned off by cyber criminals,” said Tarunima.

“That reminds me Tarunima, how are the payment made over the internet? I
have only accepted cash payments.”

“Well papa, we just need to give our bank account number and the IFSC code
to the people running these e-commerce websites and they will link it to our
payments. Any customer who will buy our suits online will pay through debit
or credit card and that money will come into our bank account. Isn’t it great?”
asked Tarunima

“Yes it is great, but I have heard that for all this online business we will have
to register with many government agencies. Who will keep running around all
these government offices for days altogether?” asked his father.

“Papa, these days no one has to run around these offices. All these offices of
Aadhar Card, PAN Card and GST will come to our shop through the internet
and our registration will be just a few clicks away.”

Activity 13.2

You are Tarun’s friend and Tarun has approached you to help him in getting
‘Bharat Tailors’ online. Find out the respective websites and note down the
specific URL to apply for these various statutory compliances.
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Going Digital Site Type Please provide the URL

PAN Card

Aadhar Card

GST

Facebook.com

Amazon.in

Twitter.com

WHAT YOU HAVE LEARNT

eBusiness

eCommerce

Finance

Supply chain
Management

Human
Resource

Customer
Management

ERP

Legal Comliances

Bussiness Buyer

Bussiness Seller

Individual Buyer

Bussiness Seller

B2B

B2C

Digital Identity

Face book

Twitter

Amazon.in

Flipkart.com

PAN

GST

ADHAAR
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TERMINAL QUESTIONS

1. E-commerce has changed the way one conducts business. Do you agree?
Please explain in detail.

2. Veena has started an online business of Handlooms (bedsheets, towels,
curtains and so on). She wants to do the e-marketing of her goods. Help
her by providing ways to do e-marketing.

3. Digital identity is both a boon and a bane. Discuss.

4.  “http://” is a secure site. Please comment if the statement is true or false
with justification.

5. Your friend wants your help in automating the inventory and finance of his
business. What solution would you suggest and why?

With Tarunima’s help and guidance, Ashok worked hard on his newly established
e-business. In two years, he was able to completely transform his old shop into
a new sparkling showroom just like e-business had transformed his life. The
board on his new showroom displayed his passion and read: ‘Bharat eTailors!’

ANSWERS TO INTEXT QUESTIONS

13.1

1. E-business and e-commerce are not same. E-commerce is a subset of the
wider concept of e-business. Where e-Business means and includes the entire
lifecycle of product/service from marketing to final distribution using the
electronic medium of internet, E-commerce is restricted to only sale and
purchase of products or services over electronic medium.

2. The tools required in e-commerce business are: Laptop/Desktop, Mobile
Phone, Tablet PC.

3. Flipkart.com, Snapdeal.com, Amazon.in

4. (i) False. E-business means conducting business over an electronic medium
such as internet.

(ii) False. E-commerce portals offer many products like clothes, furniture,
electronic goods, mobile phones, computers, etc.

(iii) False. E-commerce portals reach thousands of customers using the
power of internet.
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Online StoreàOrder Placement by BuyeràOnline Payment by BuyeràOrder
Processing by SelleràShipping the Product by SelleràBuyer Receives the
ProductàSeller requests FeedbackàBuyer gives Feedback

6. Steps to find air conditioner:

(i) Go to flipkart.com and search for air conditioners

(ii) Filter on the size and type you want to buy

(iii) Compare price and specifications between various makes

(iv) Pick the one you find matching your requirement

(v) Click on ‘add to cart’

(vi) Go to cart and click on ‘Online Payment Through Bank’

(vii) Put your account details and click on ‘Submit’

7. B2C

8. B2B

13.2

1. It is important to create a digital identity for selling online goods because
one can only join and e-commerce platform using a digital identity.

2. All processes like Finance, Supply Chain Management, HR, Admin and
Customer Management can be handled through ERP.

3. SAP, ORACLE, RAMCO.

4. Domain Name RegistrationàStatutory ComplianceàSocial Identity
CreationàRegistration on e-commerce portalsàOnline Promotion and Social
Media IntegrationàPayment Gateway IntegrationàDocument Managementà
ERP Integration
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14

CYBER SECURITY

“Wow, we are rich! Just come and have look at this Tarunima!” exclaimed father
with joy while looking at Tarunima’s laptop one fine day.

“What is it papa?” asked Tarunima as she looked at the computer and found
an e-mail claiming that her father had won One million Pounds in lottery. The
mail had a suspicious looking file attached to it and the email asked the recipient
to double click the file and fill the relevant details. “No papa! Don’t open it.
It must be a malware.” Along with Tarunima and her father, we will learn to
protect ourselves and our business from various cybercrimes.

OBJECTIVES

With Tarunima’s help, you and his father will be able to:

become aware of potential cyberthreats like virus, malware, adware, spam,
Trojan, worm, spyware and others from devices;

protect oneself from various cybercrimes like, phishing, identity thefts,
Plagiarism and others;

resolve issues related to computer and network security threats by keeping
strong passwords, security checks, not allowing hardware, keeping antivirus
in the system and not committing cybercrimes;

develop the netiquettes for becoming responsible citizen; and

explain the provisions of Indian IT act.

14.1 CYBER THREATS

“Malware?” exclaims Tarunima’s father looking very disturbed.

“Yes, malware. Well, actually it is a software which is malicious or harmful in
nature. Once opened, it harms our computer in many ways. That’s why it is called
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can it harm our computer?” father was now anxious. “You see papa, there are
many types of malwares in this world of web. The most common ones are
viruses, worms, Trojan horses, ransomware, spyware, adware, scareware, and
other malicious programs. Let me explain in detail about potential cyberthreats

1. Virus – “Papa, remember you told me that a virus is an infectious agent
that can multiply only in living cells of animals, plants or bacteria when you
were explaining about HIV. Similarly, a computer virus is a malware which
copies itself and infects a computer without the knowledge of the user. It
has the ability to attach itself to a file while it is being sent or emailed. As
soon as the recipient of the email opens the file by double clicking it, the
virus gets activated and infects the recipient’s computer by deleting
important files and attaching itself to many others. In this way it continues
to spread further. Just as HIV destroys human body, computer virus does
the same to computer.”

2. Worm–“A worm is another malware which spreads from one computer to
another over the network but does not delete any files. It just replicates itself
over the network and consumes bandwidth, thereby making the network
slower than usual. Just like I used be tired and slow when I had worms in
my stomach!”

3. Trojan Horse – Unlike the Trojan Horse depicted in the Greek Mythology
which was used, to send soldiers inside an enemy territory, this Trojan horse
in the world of computers is a malicious program. It is disguised as a
legitimate application such as a game being offered free of cost. Once
downloaded, it takes control of the computer and can even send sensitive
information like one’s password or bank details to the owner of this Trojan
horse over the internet.

4. Ransomware – A ransomware is an application which forces one to pay
a ransom or money to get rid of it. It enters your computer just like any
other computer virus or Trojan horse disguised as a free game, etc. but
instead of harming the computer it locks it forever and shows a message
on the computer screen with the contact details of the people who could
help remove it. Once contacted, one is asked to deposit a certain sum of
money in a bank account to have this application removed from the system.
This kind of application which holds one to ransom to cybercriminals is
called as a ransomware and is the latest threat to the world of web.

5. Spyware–It is a software that enables a user to obtain sensitive information
such as website accessed, downloaded from another computer by transmitting
data from the hard drive without the user’s knowledge.
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advertising material such as banners or pop-ups when a user is online.

7. Scareware – A scareware is a malicious computer program designed to trick
a user into buying and downloading unnecessary and potentially dangerous
software, such as fake antivirus protection.

8. Spam mail –Spam is flooding the internet with many copies of the same
message, in an attempt to force the message on people who would not
otherwise choose to receive it. “Papa, we must take care that we do not
send spam mails. It annoys the receiver and can even end up in negative
image of our business.”

9. Hacker -  A hacker is a person who uses computers to gain unauthorized
access to data. Hackers are most often computer enthusiasts or programmers
looking for advanced knowledge on programming languages or operating
systems.

Activity 14.1

I am a piece of 
code that is secretly 

introduced into a system 
in order to corrupt it or 

destroy data.

I am _________________ I am _________________

I am a self-replicating 
computerprogram who uses 

a computer network to send copies 
of myself to other nodes on the 

network without any 
user intervention

(a) (b)

I am _________________ I am _________________

(c) (d)I am a non-self-replicating 
malware that appears to perform 
a desirable function for the user 

but instead facilitates unauthorized 
access to the user's computer 

system.

I am the term used to 
define all sorts of software 
designed to cause harm to a 

computer system.
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I am _________________ I am _________________

(e) (f)
I keep track of web pages
that you look at and then
send the data to a third

party.

I am unsolicited mail 
that has not received 

permission from a recipient 
to enter its inbox.

I am _________________

(h)
I am a programmer who 
enjoys the challenge of 

breaking into other's
computers.

14.2 PROTECTION FROM CYBERTHREATS

“Oh my God, these are so many! How do we save ourselves from these
malwares?” asked father looking a bit scared. “Well, there are some dos and
don’ts which I will elaborate later but the first and foremost thing we should
do is to install a good antivirus software in our computer.”

“Antivirus?”

“Yes papa, an antivirus. It is a software program that routinely checks for any
malware entering our computer and destroying it.”

Antivirus – Antivirus software is a program or set of programs that are
designed to prevent, search for, detect, and remove software viruses, and
other malicious software like worms and Trojans. Examples MacAfee,
Norton, Quick Heal, AVG and others.

“And what are those dos and don’ts you said you’ll tell me later?”

“So papa, here are the dos and don’ts in Table 14.1.”
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             DOs             DON’Ts

Install an antivirus in your computer. Do not open any unsolicited mail.

Update the antivirus regularly. Do not download any tool/application
from internet whose publisher is unknown.

Always buys licensed software for Do not download any free game or
your computer. application. Nothing is free in this world.

Enable the spam filter on antivirus. Do not visit obscene websites. These
are created by cyber criminals to take
control of your computers.

Enable email scanning on antivirus. Do not keep any sensitive information
like passwords, credit/debit card nos.

on your computer.

“Thank God! We have antivirus to protect our data.” Father took a sigh of relief.

“But this is not enough Papa, we should also be aware of various cyber
crimes that we may commit unintentionally” Tarunima  said. “Please tell
me about various cyber crimes also,” asked Father. “Papa let us first
understand what cyber crime is! Cyber crime refers to any crime that
involves computer, mobile or a network. It is an unlawful act wherein the
computer is used as either a tool or target or both.”

Some cyber crimes are:

1. Plagiarism – Many people think of plagiarism as copying another’s work
or borrowing someone else’s original ideas. But terms like “copying” and
“borrowing” can disguise the seriousness of the offence: Dictionary meaning
of “plagiarize “ is to steal and pass off the ideas or words of another as one’s
own or to use another’s production without crediting the source or to
commit literary theft.”

In other words, plagiarism is an act of fraud. It involves both stealing
someone’s original work and falsely claiming it as one’s own. We can avoid
this by giving credits to the sources and providing necessary information to
locate it. “Papa we must never do this. Internet lets us see the designs of best
people in this field. While it’s great to be inspired by such designs it’s not right
to copy someone else’s work and call it ours. It is cheating and all cheats get
caught sometime or the other. It also does not give us the opportunity to grow
as an independent professional.”
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Going Digital 2. Phishing – It is a form of fraud in which the attacker tries to learn
information such as user name, password, credit card details or bank account
information, often for malicious reasons by disguising as a reputable or
trustworthy entity in an email or through another communication channel.

3. Identity Theft - It is a serious crime which happens when someone uses
personal and confidential information without the permission of the concerned
person. They could use your name and address, credit card or bank account
numbers, adhaar card numbers, medical insurance account numbers or any
other sensitive data.

4. Computer Vandalism – Damaging or destroying data rather than stealing
or misusing them is called cyber vandalism. These are programs that attach
themselves to a file and then circulate.

5. Denial of Service Attacks – This is an act by the criminals who flood the
bandwidth of the victim’s network or fills his email box with spam mail
depriving him of the service he is entitled to access or provide.

6. Cyber Stalking – It is a crime in which the attacker harasses a victim using
electronic communication, such as email or instant messaging or messages
posted to web site or a discussion group.

“Papa, now that we are trying to enter into online business we must install
licensed antivirus in systems to protect our financial, personal and confidential
data. The people behind these crimes feel that they can hide behind the internet
and are safe. However, there are a lot of checks and balances. Ultimately, they
are always caught and are punished under the laws.”

You will learn more about these laws further in this lesson. Don’t you think
that each one of us should develop the ability to say ‘no’ if someone tries to
include us in such activities?

IN TEXT QUESTIONS 14.1

1. Define the following:

(i) Malware  _________________________________________________

________________________________________________________

(ii) Adware    ________________________________________________

________________________________________________________

(iii) Cybercrime  _____________________________________________

________________________________________________________
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________________________________________________________

2. Give two differences between computer virus and anti-virus.

(i) ________________________________________________________

(ii) ________________________________________________________

3. What effects can malicious viruses have on your system if the following
attack you?

(i) Trojan Horse ______________________________________________

(ii) Scareware ________________________________________________

(iii) Ransomware _______________________________________________

4. List three methods by which computer viruses can spread.

(i) ________________________________________________________

(ii) ________________________________________________________

(iii) ________________________________________________________

14.3 SAFETY TIPS FOR CYBER SECURITY

“And what are those dos and don’ts you said you’ll tell me later?”

“So papa, here are the dos and don’ts for cyber security in Table 14.2”

Table 14.2: Safety Tips for Cyber Security

                  DOs                    DON’Ts

Install an antivirus in your computer. Do not open or respond to emails sent
from unknown sources.

Update the antivirus regularly. Do not download any tool/application
from internet whose publisher is unknown.

Always buy licensed software for your Do not download any free game or
computer. application. Nothing is free in this world.

Enable the spam filter on antivirus. Do not visit obscene websites. These are
created by cybercriminals to take control
of your computers.
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passwords, credit/debit card numbers on
your computer.

Passwords should be changed regularly Do not plug any USB drive (pen drive)
to maintain security. without scanning it properly.

Always keep strong passwords with 8 Do not use your PAN card, Voter id,
or more character length. Password driving license number as your username
should be the combination of capital, or password for any financial account.
small letters, digits with special symbols.

Use the “Bcc” (Blind Carbon Copy) for Do not give your personal details of
large number of recipients. This protects account number, credit card number, pin
the email addresses of the recipients by number etc. and become the victim of
hiding them and makes your email easier Phishing.
to read.

Always check the URL address begins Do not use public Wi-Fi network for
online
with “https” and not “http” while banking.
transacting online.

Setup account notification via SMS or Do not get trapped in email scams like
email. This will help you keep an eye lottery emails, it should be avoided.
over your login attempts related to
your account.

14.4 NETIQUETTES OF A RESPONSIBLE CITIZEN

“Papa, now I want to ask a question from you,” Tarunima said.

“From me?” asks the astonished Father.

“Papa, what are the responsibilities of a citizen?” asked Tarunima,

“It’s very simple. We have to perform our duties such as we have to take care
of public property, we should pay taxes on time, give equal respect to all religions
and cultures according to the constitutional remedies of India etc,” father
responded.

“Well said Papa. Now you know, there are some responsibilities of a Netizen
also.” Tarunima said. “Netizen! What’s that??” asked father. “If you are using
internet means NET, it means you are a citizen of the Internet or in other words
have become NETIZEN, who uses internet for its services. As a responsible
citizen of internet you must follow some etiquettes while surfing. This is called
Netiquettes.”

Digital Footprint

A digital footprint is a trail of data you create while using the Internet. In
includes the websites you visit, emails you send, andinformation you submit
to online services.
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as a set of rules for acceptable online behaviour. 

Fig. 14.1: Rules of Netiquettes

Netiquette rules are as follows:

1. The Golden Rule- Treat others as you would like to be treated. Avoid
language that may not be understood by the recipient, for example, slang.

2. No Flaming- Flame is a personal insult communicated through the internet.
Watch your posts or comments.

3. Don’t talk with people you don’t know - Do not arrange to meet anyone
you meet online.

4. Respect other people’s privacy–Respect other people’s time and bandwidth.

5. Don’t spam- It is an unsolicited email from unknown resources.

6. Follow the TOS – (Terms of service) Follow rules and policy of the sites.

7. Use emoticons – Use of emojis can help to convey feelings.

8. Respect Copyright–Don’t violate copyright laws. Make sure your work is
your own or properly cited.
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Going Digital 9. Do not capitalize everything– It looks like you are shouting.

10. Remember that you leave a digital footprint - So be careful what you
put out there.

“Oh my goodness! We have to take care of so many things while surfing the
internet.” Father said. “Yes papa. If we violate any rule then we can be a violating
the Cyberlaw and can be punished,” Tarunima said. “One should be well
informed about Cyberlaws of India, that is, Indian IT act.”

“I think internet is a very dangerous place for young boys, with all the obscene
sites. It is also dangerous for young girls, what if someone traps them,” said
father. “I understand that you are worried papa,” said Tarunima, “It’s not about
age papa. It’s about the ability to make a decision to indulge or not to indulge
in these activities. People of any age can do it if they do not have the skills
to say ‘no’.”  “Don’t worry papa, I will always think and study the authenticity
of the site before I access it.” “I am so proud of you Tarunima!”

INTEXT QUESTIONS 14.2

1. In the table below, define:

Netiquette

Digital Footprint

TOS

2.  Give four ways by which you can protect yourself from a malware attack.

(i) _________________________________________________________

(ii) _________________________________________________________

(iii)_________________________________________________________

(iv)_________________________________________________________
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(i) _________________________________________________________

(ii) _________________________________________________________

(iii)_________________________________________________________

14.5 CYBERLAWS IN INDIA

As more and more business is being conducted online, the government has
drafted cyberlaws that help us seek legal recourse if someone cheats us. The
Information Technology Act, 2000 is the primary source of cyberlaw in India.
The Information Technology Act, 2000 (IT Act) came into force on 17 October
2000. The Act aims to provide legal recognition to electronic commerce. In
addition it facilitates the filing of electronic records with the government. The
IT Act also penalizes various cybercrimes and provides strict punishments. Some
of the offences along with the punishments are given in Table 14.3:

Table 14.3: Offences and Punishments in Cyberlaws

            Offences               Punishment

Damaging the Data or the Computer: Fine up to 1 crore to the affected person
Any person who deletes or causes as a remedy
disruption of any computer with the
intention of damaging of the whole data
of the computer system without the
permission of the owner

Hacking: Any person with intention Imprisonment up to three years, or with
causes wrongful loss or damage to fine which may extend up to 2 lakh
public or any person commits hacking rupees, or with both.

Publishing of obscene information in On first conviction, person shall be liable
electronic form: Any person who to imprisonment which may extend up to
knowingly or intentionally publishes five years and fine up to rupees 1 lakh.
pornographic material in electronic form. On second conviction, imprisonment up to

 ten years and fine up to 2 lakh rupees.

Cyber Defamation: Any person who Imprisonment for a term which may extend
sends, by means of a computer resource to three years and with fine suited to the
or a communication device, any crime.
information that is grossly offensive,
which causes annoyance, inconvenience,
danger, obstruction, insult, injury, enmity,
hatred and annoyance or mislead the

addressee.
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culprits were punished. In a case from Chennai, a boy started harassing a girl
when she refused to marry him. The boy posted obscene, defamatory and
annoying message in the message group, emailed those through a false email
account opened by him in the name of the victim. Upon girl’s and her family’s
complaint, police nabbed the accused. The accused was found guilty of offences
under Section 469, 509 of Indian Penal Code and Section 67 of IT Act 2000
and was convicted with imprisonment for 2 years and to pay fine of Rs. 4000/
-. While it is normal to like someone, it is not right to force attention on an
unwilling person. Just as we have the right to express our feelings, the other
person also has the right to express theirs. Don’t you feel that this young person
from Chennai went too far and finally landed in jail!

Recently, Mumbai police arrested a man for allegedly defrauding a city resident
of Rs 94,000 on the pretext of giving him a job. Victim was looking for a job
and had applied on a well-known job portal. After checking his details on the
portal, accused called him up claiming to be representing a company looking
for people and demanded a fee before the victim could be called in for an
interview. After few weeks, accused stopped responding. On complaint at
cybercrime police station, the police tracked down the accused and placed him
under formal arrest under IT Act.

In view of such increase in cybercrimes, the Government of India has brought
major amendments to ITA 2000 by the Information Technology Amendment Act,
2008  (ITAA 2008). The new version of Information Technology Act 2000 gives
additional focus on Information Security. It has added several new sections on
offences including cybercrime and data protection.

To tackle the issue of cybercrimes, CIDs (Criminal Investigation Departments)
of various cities have opened up Cyber Crime Cells in different cities. The
Information Technology Act of India states clearly that when a cybercrime is
committed, it has a global jurisdiction and hence a complaint can be filed at any
cyber cell. This means you can register a complaint even if the criminal is in
another city!!

(Credits: https://blog.ipleaders.in/how-to-register-cyber-crime-complaint-with-cyber-cell-of-
police-online-complaint-procedure/)

14.5.1 How to file Cyber Crime Complaint

Just two steps and a complaint can be filed.

Step 1 -Submit an application letter addressing the head of a cybercrime
investigation cell when filing a complaint. One may need to provide contact
details such as name, mailing address and telephone number along with it.

Step 2- Submit relevant documents along with the application to register a
complaint.
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CBI Cyber Crime Cell: Asst. Commissioner of Police,

Superintendent of Police, Cyber Crime Cell,

Cyber Crime Investigation Cell EOW, Crime Branch,

Central Bureau of Investigation, 2nd Floor,

5th Floor, Block No.3, Police Training School,

CGO Complex, Malaviya Nagar,

Lodhi Road, New Delhi-110 017

New Delhi – 3 E-Mail:  cbiccic@bol.net.in,

Contact Details:           dcp-eow-dl@nic.in

+91-11-4362203, 011-26851998

011-26515229, +91-11-4392424

Web site: http://cbi.nic.in/

Similarly every city has its own cyber cells. It will be a good idea to find
out the contact details for any emergency.  Better safe than sorry!
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TERMINAL EXERCISE

1 Explain the term malware. What are the different kinds of malware that are
commonly seen?

2. The term virus has been taken from medicine? Describe two ways in which
the two viruses are similar.

3. Give three ways in which you can protect your computer system against
viruses.

4. Write a notice for your employees explaining what spam is and the office
non-spam policy giving reasons. Tell them two ways to avoid getting
spammed.

5. Define plagiarism. Give two arguments against plagiarism.

6. Give two differences between phishing and identity theft. Suggest four ways
of protecting yourself from such crimes.

7. Your class fellow Manish has just started his new online business of
providing nursing facility to old age people in the city. He has given the
facility of online bookings and payments. Write a letter to Manish informing
him about five different netiquettes that he should observe while dealing with
his clients

8. Name the law by which cyber crimes are controlled in India? Write a
complaint to the cyber cell of your city about the cyber stalking in which
you were victimized.

ANSWERS TO INTEXT QUESTIONS

14.1

1 (i) Malware is a short form of “malicious software” which is specifically
designed to disrupt, damage, or gain authorized access to a computer
system.

(ii) Adware is a software that contains embedded advertisements. It is
designed to display advertisements on your computer and redirect your
search requests to advertising websites to collect marketing data about
you.

(iii) Cybercrime is defined as a crime in which a computer is the object of
the crime (hacking, phishing, spamming) or is used as a tool to commit
an offense.
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Going Digital(iv) Plagiarism is presenting someone else’s work or ideas as your own, with
or without their consent, by incorporating it into your work without full
acknowledgement. All published and unpublished material, whether in
manuscript, printed or electronic form.

2                Virus                     Antivirus

It is computer program/software It is a computer program/software
which infects computer badly which eliminates viruses from
and damages the data. computer.
A virus can benefit the spreader of An antivirus is beneficial to the people
the virus or the programmer who uses  who got infected by the virus. Antivirus
it. A virus can be easily uploaded or software needs to be purchased.
copied on the web.

3. (i) A Trojan horse gives remote access of your computer to other users
and allows them to install malicious software on it.

(ii) Scareware would pop up hoax virus infection warnings and would scare
you to buy a fake antivirus or registry cleaner.

(iii)  A ransomware would take control of your computer, hide or password
protect all the files, and would ask you to pay money for unlocking such
files.

4. Computer viruses can be spread by:

Opening attachments in an email

Files stored on removable media such as floppy disk, pen drives and
others

Downloading free software from the internet

Clicking on some pop-ups on web pages

 14.2

1. (i) Netiquette- The correct or acceptable way of using net is called as
netiquette.

(ii) Digital footprint means and includes the information about a particular
person that exists on the Internet as a result of their online activity.

(iii) TOS- Terms of Service of a website, which a user has to adhere in order
to use it.
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Going Digital 2. (i) Update your software regularly.

(ii) Install anti-virus software on your computer.

(iii) Create Backups of your data periodically.

(iv) Update anti-virus software periodically.

3. (i) We should never click on email attachments from unknown resources
without at least first scanning them for viruses.

(ii) We should never share user account, personal, financial, or other
sensitive information on any Web page.

(iii)  Many viruses work by attaching themselves to a drive and automatically
installing themselves on any other media connected to the system. As
a result, connecting any network drives, external hard disks, or even
pen drives to a system can result in the automatic propagation of such
threats.
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